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NOTICES Notices
References in this publication to IBM products, programs, or services do not imply that IBM intends to make these available in all countries
in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product,
program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any of the intellectual
property rights of IBM may be used instead of the IBM product, program, or service. The evaluation and verification of operation in
conjunction with other products, except those expressly designated by IBM, are the responsibility of the user.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not
give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 208
Harbor Drive, Stamford, CT, USA 06904-2501.

IBM may change this publication, the product described herein, or both.
Subtopics

SOFTCOP Softcopy Publications
TRADEMARK Trademarks
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SOFTCOPY Softcopy Publications

AUTHORIZED USE OF IBM MACHINE-READABLE DOCUMENTS

ANY USE OF THE IBM MACHINE-READABLE DOCUMENTS, INCLUDING READING FROM THE
ORIGINAL MEDIA, INDICATES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT
AGREE WITH THE TERMS, PROMPTLY RETURN THE ORIGINAL MEDIA AND THE AMOUNT
YOU PAID WILL BE REFUNDED. YOUR FAILURE TO COMPLY WITH THESE TERMS
TERMINATES THIS AUTHORIZATION. UPON TERMINATION, Y OU MUST DESTROY THE

DOCUMENTS AND ALL COPIES.

"Document" means the original copy of a document an
copy you make. The Document is copyrighted. I1BM d
to the Document. A Document may be either general
may contain general and licensed Documents. Differ
general and licensed Documents.

General Document

A general Document has an order number usually begi
ng v

You may make copies, modify, and print the general
your enterprise. You may transfer possession of th
another party only when you transfer the related IB
either machines you own, or programs, if the progra
permit a transfer). If you do so, you must give th
original unaltered copy of the general Document.

Licensed Document

A licensed Document has an order number beginning w
Document is part of a specific program that IBM lic
have a license agreement with IBM for the program,
order to use, copy, or print the licensed Documents
license agreement apply to the licensed Documents a
make from them.

Under each license, IBM authorizes you to:

1. Use the licensed Document on all machines desig
program or on other machines within your enterp
of authorized use of the program; and 2. Make

print the licensed Document.

You agree to use the licensed Document only as auth
NOT do, for example, any of the following:

1. Sublicense, assign, or transfer the license for
Distribute the licensed Document to any third party

Warranty

The warranty for IBM programs, contained in your li
applies to the licensed Documents. All other Docum

IS." THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, |

d any copy or partial
oes not transfer title

or licensed. The media
ent terms apply to

nning with a "G" or an

Document for use within
e general Document to
M product (which may be
m's license terms

e other party an

ith an "L." A licensed
enses to you. You MUST
or the Document, in

. The terms of your

nd to any copies you

nated for the
rise in support
copies, modify, and

orized above. You may

any Document; or 2.

cense agreement,
ents are provided "AS

NCLUDING THE WARRANTIES

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR POSE. Some

jurisdictions do not allow the exclusion of implied
above exclusion may not apply to you.

General

You may transfer possession of the original media (
containing the Documents if the media has an order
"G" or an "S." Such media may contain licensed Docu
readable without the appropriate "keys" to unlock t
transfer such keys. You may NOT transfer the origi

warranties, so the

such as CD-ROM discs)
number beginning with a
ments, but they are not
hem. You may NOT

nal media that has an
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Softcopy Publications

order number beginning with an "L."

For each Document you must reproduce the copyright notice, any other
legend of ownership, and all warning statements, on each copy or partial
copy of the Document.

If you acquired the media in the United States, thi s authorization is
governed by the laws of the State of New York. If you acquired the media
in Canada, this authorization is governed by the la ws of the Province of
Ontario. Otherwise, this authorization is governed by the laws of the

country in which you acquired the media.

January 1994
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Trademarks

TRADEMARKS Trademarks

The following terms, denoted by an asterisk (*) on their first occurrence in this publication, are trademarks, or registered trademarks, of
the IBM Corporation in the United States or other countries:

AIX

BookManager

IBM

Library Reader
Operating System/2
0S/2

Personal System/2
PS/2

WIN-0S/2

The following terms, denoted by a double asterisk (**) on their first occurrence in this publication, are trademarks, or registered
trademarks, of other companies:

Adobe Adobe Systems Incorporated
ImageStream Graphics Filters ImageMark Software Labs, Inc.
Microsoft Microsoft Corporation

PostScript Adobe Systems Incorporated
TrueType Apple Compulter, Inc.

Windows Microsoft Corporation

Windows NT Microsoft Corporation
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About This Book
ABOUT About This Book

The User's Guide helps you install and get started using IBM* BookManager* Library Reader for Windows**. It explains what softcopy is

and introduces you to BookManager Library Reader for Windows. It covers many of the most important tasks you need to know when
using Library Reader for Windows.

Subtopics

WH(Who Should Use This Book

CONVENTION Conventions Followed in This Book
MOREINF(Where to Find More Information
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Who Should Use This Book
WHO Who Should Use This Book

This book is for anyone who installs or uses BookManager Library Reader for Windows.

Subtopics
ABOUT.WHO.: Prerequisite Knowledge
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Prerequisite Knowledge

ABOUT.WHO.1 Prerequisite Knowledge

This book does not expect you to be familiar with BookManager, but it does assume that you have some experience with Microsoft**
Windows, and that you are comfortable doing basic Windows tasks such as:

Starting Program Manager and File Manager
Making a window active

Maximizing, minimizing, and restoring windows
Moving and sizing windows

Using scroll bars

Cutting and pasting

ODoooQgg

If you need other or more detailed information on how to work with Windows, refer to any of the following Windows documentation:

Microsoft Windows User's Guide
Microsoft Windows Online Help
Microsoft Windows Tutorial
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CONVENTIONS Conventions Followed in This Book

Subtopics

CONVENTIONS.: Conventions for Instructions
CONVENTIONS.: Terminology Conventions
CONVENTIONS.: Visual Conventions
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Conventions for Instructions

CONVENTIONS.1 Conventions for Instructions
All sets of instructions begin with an introductory sentence in a shaded box so you can spot them quickly.

The instructions in the User's Guide are mouse-based. You can find shortcut keys for menus on the Keys Help .
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Terminology Conventions

CONVENTIONS.2 Terminology Conventions

File/Copy A short way of saying "From the File menu, choose Copy ."

View/Sort>By Title A short way of saying "Choose the cascading command button By Title from the Sort menu command in the View
menu."

This book uses the terms "select" and "choose" as Microsoft Windows documentation does:

Select To mark a region of text or graphics on which a subsequent action will be taken. When you select an item, it is highlighted in
some way; for example, when you select a checkbox, a checkmark or an x appears in it.

Choose To pick a menu or command button whose action will be implemented immediately. When you choose an item, the display on
your screen changes; for example, when you choose OK on a dialog box, it closes.
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Visual Conventions

CONVENTIONS.3 Visual Conventions

ALL CAPITALS
Directory names, file names, and acronyms.
monospace
Characters that you must type exactly as they appear in the book. For example, to start BookManager Library Reader for
Windows, you would type readibm exactly as it is spelled.
Ctrl+O
A plus sign (+) between key names means to press and hold the first key while you also press the second key. For example,
"press Ctrl+O" means to press and hold Ctrl while you also press the O key, then release both keys.
EXAMPLE
Identifies examples in instructions.
italics
Terms that are defined in this book's glossary. References to titles of other books are also italicized.

In step-by-step instructions, any information in italics represents information that you must provide. For example, if an instruction
tells you to type file name, then you should type the actual name of the file you want instead of the words "file name".
Boldface
Terms that appear on the interface, such as push button names and menu commands.
TIP:
A light bulb signifies a bright idea--a usage tip that might make doing your Library Reader for Windows task faster or easier.
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MOREINFO Where to Find More Information

This book contains introductory information to get you started using BookManager Library Reader for Windows. The following information
completes the library for this product:

Hardcopy

IBM BookManager READ: License Information, GC34-3059

Softcopy

IBM BookManager Library Reader for Windows: User's Guide

Online Helps

Other reference materials pertaining to the BookManager family of products are listed in the Bibliography.
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Introducing BookManager Library Reader for Windows
1.0 Introducing BookManager Library Reader for Wind ows
IBM BookManager Library Reader for Windows is an application that lets you read, search, navigate through, and make notes in softcopy
documents that were created using any IBM BookManager BUILD product.

Subtopics
1.1 New Features in BookManager Library Reader for Win dows
1.2 Standard Features in BookManager Library Reader fo r Windows

1.3 Other IBM BookManager products
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New Features in BookManager Library Reader for Windows

1.1 New Features in BookManager Library Reader for Windows
BookManager Library Reader for Windows offers these new features:
Bookcases Organizing Your Data

[ The ability to organize bookshelves into bookcases. You can also nest bookcases within other bookcases.

Intuitive user interface
[ A user interface in the Microsoft Windows style, with a tool bar to help you run menu commands quickly
[1 Book text displayed in proportional fonts

[ Book text that can reflow--that is, reformat to stay visible within the window when the window is resized

Robust search capabilities

[ Ability to focus a search on book titles, topic titles, or index entries

[ Ability to search using wildcard characters (* and ?)

[1 Boolean searching; that is, combining search words and phrases with AND, OR, and BUT.

[ User exits that allow you to track book usage, or customize your search requests

Enhanced graphics

Integrated pictures (pictures inserted between lines of book text)
Ability to display high-quality color images

Ability to pan and zoom pictures

Ability to print pictures, or copy them to the Windows Clipboard

I

Printing

[ Ability to print marked text

[ Ability to print on any installed printer

[ Ability to preview printed material online before printing

Hypertext and retrievability

[ Linking to other books in the same bookshelf (or the same List of Books), or linking to other programs or applications (including
multimedia)

[ An optional bookmark you can place anywhere in the book, anytime

1 Copyright IBM Corp. 1989, 1994
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Standard Features in BookManager Library Reader for Windows

1.2 Standard Features in BookManager Library Reader for Windows
These features are found in all BookManager READ products, including BookManager Library Reader for Windows:

Electronic bookshelves

Electronic bookcases

Electronic notes you can attach to a book for your private use

Ability to read the electronic notes given to you by others

Bookshelf searching

Ranked search results

Linking to topics, figures, tables, pictures, list items, footnotes, or author-selected spots within the book
Printing or copying of the entire book or selected topics

Easy return to topics you have already seen

ODooooooog
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Other IBM BookManager products

1.3 Other IBM BookManager products
BookManager Library Reader for Windows is part of the IBM BookManager family. The other family products are:

IBM BookManager READ/DOS IBM AlX* BookManager READ/6000
IBM BookManager READ/2 IBM BookManager BUILD/2

IBM BookManager READ/MVS IBM BookManager BUILD/MVS

IBM BookManager READ/VM IBM BookManager BUILD/VM

IBM BookManager READ for OS/2 IBM BookManager BUILD/SGML
IBM BookManager BookServer for WWW for OS/2

IBM BookManager BookServer for WWW for AIX

IBM BookManager READ for Windows

IBM BookManager BUILD for Windows NT**
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Getting Started with BookManager Library Reader for Windows
2.0 Getting Started with BookManager Library Reader for Windows
The User's Guide provides step-by-step instructions to help you get started using BookManager Library Reader for Windows. Each
chapter explains a basic Library Reader for Windows task or function. Once you get started, you'll find it easy to navigate through a
softcopy book using the online Help as you need to.
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3.0 What You Need to Know Before Starting
This chapter covers a few essential things you need to understand to get the most out of Library Reader for Windows.

Subtopics

3.1 Working with Softcopy Information

3.2 Where Do Books, Bookshelves, and Bookcases Reside?
3.3 Reflowable Text

3.4 Getting Help When You Need It
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W orking with Softcopy Information

3.1 Working with Softcopy Information

BookManager organizes softcopy information into softcopy books. You can read these books individually and combine them into groups
called bookshelves. You can combine bookshelves into bookcases.

With BookManager Library Reader for Windows you can easily view the contents of a softcopy book as well as lists of:

All bookcases available to you

All bookshelves available to you
The books in a particular bookshelf
The books in a particular path

I

Subtopics

3.1.1 What is a Softcopy Book?
3.1.2 What is a Bookshelf?
3.1.3 What is a Bookcase?
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What is a Softcopy Book?

3.1.1 What is a Softcopy Book?

A softcopy book is a computer file with an extension .BOO. It contains text that an author wrote, along with any figures or illustrations. The
icons (1) that identify an unopened softcopy book are

or

or

(The book icons that show a list indicate that the book is listed in a search index, which makes searching faster.)

You can't read the softcopy book with an ordinary word processor or text editor, but under most circumstances a softcopy book built
using any BookManager BUILD product can be read with any of the BookManager READ products. (2)

Each softcopy book is divided into chunks of information called topics. Just as printed books have chapter headings and page numbers,
softcopy books use topic identifiers to let you know where you are. The topic ID can be the name of a part of the book, like GLOSSARY,
or a number like 1.2, which corresponds to section 1.2 in a printed book.
Softcopy books can be stored individually or can be organized into bookshelves, just as you might do with printed books.
(2) In File Manager, book and bookshelf files are represented by the standard Windows file icon.
(2) The exceptions are:

1. BookManager Library Reader for Windows cannot read books built using a BookManager BUILD 1.0 or 1.1 product.

2. You will not be able to reflow topic text or link to other applications if you

a. use BookManager Library Reader for Windows to read a book built with a BookManager BUILD 1.2 product, or
b. use a BookManager READ 1.2 product to read a book built with a BookManager BUILD 1.3 product.
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What is a Bookshelf?

3.1.2 What is a Bookshelf?

A BookManager bookshelf groups books together for easier reference. A computer file with an extension .BKS, a bookshelf contains a list
of the books assigned to the shelf. The icon that identifies an unopened BookManager bookshelf is

Unlike its real-world counterpart, the BookManager bookshelf does not actually contain any books; instead, it contains only a list of their
names and other identifying information. That means that when you remove a book from a bookshelf, you are only removing the book's
name from the list; you are not deleting the book from your system.
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What is a Bookcase?

3.1.3 What is a Bookcase?

A BookManager bookcase groups bookshelves together for easier reference. A bookcase can also contain other bookcases. A computer
file with an extension .BKC, a bookcase contains a list of the bookshelves and bookcases assigned to the bookcase.

1 Copyright IBM Corp. 1989, 1994
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Where Do Books, Bookshelves, and Bookcases Reside?

3.2 Where Do Books, Bookshelves, and Bookcases Resi de?

Your softcopy books, bookshelves, and bookcases reside in a path and directory that is specified during installation, for example,
C:\BOOKS. These directories are specified in your startup path.

The startup path typically identifies all drives and directories in which you store Library Reader for Windows bookcases, bookshelves,
books, and related files such as bookshelf search index files.

1 Copyright IBM Corp. 1989, 1994
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Reflowable Text

3.3 Reflowable Text

Reflowable text, or "word wrap," refers to text in a softcopy book that dynamically adjusts its line width to fit window size. Reflowable text
reformats itself to fit a window when you size it larger or smaller.

You can pick different fonts for both reflowable and nonreflowable text.

If you are using BookManager Library Reader for Windows to read a softcopy book built with a BookManager BUILD 1.3 product, then
ordinary topic text reflows automatically when the Book window changes size. However, certain book elements, such as figures, tables,
examples, right-justified text, and tabbed or columnar information, and certain topics in the book, such as the table of contents and index,
do not reflow.

Note: Text in BookManager BUILD 1.2 books does not reflow when read with BookManager Library Reader for Windows, and text in
BookManager BUILD 1.3 books does not reflow when read with a BookManager READ 1.2 product.
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Getting Help When You Need It

3.4 Getting Help When You Need It

BookManager Library Reader for Windows uses the Microsoft Windows Help system to provide online help information that you can easily
access while doing any Library Reader for Windows task. Online help is available from any window that has a Help menu, and from any
dialog box that has a Help command button. BookManager Library Reader for Windows offers the following kinds of online help:

Contents help
Describes the overall purpose, use, and contents of a window.

Context-sensitive help
Describes the specific purpose and use of the menu commands in most windows, and the tool bar icons in the Book

Short help
A one-line description of each menu command in certain windows, or each tool bar icon in the Book window, displayed in
the status bar of the window.

For detailed information on how to use the Help window itself, which appears when you request help, choose How to Use Help from any
Help menu, or see the Microsoft Windows User's Guide.

Subtopics

3.4.1 Understanding the Help Menu
3.4.2 Getting Contents Help

3.4.3 Getting Context-Sensitive Help
3.4.4 Getting Short Help
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3.4.1 Understanding the Help Menu

A Help menu is present in every menu bar, and the same commands are available in all Help menus. Here's what they do:

Help Index
Displays an alphabetical list of help topics available for the active window.

How to Use Help
Describes how to use online help

Contents
Provides a general description of a window's purpose and use.

Task Help
Displays an alphabetical list of instructions for doing BookManager Library Reader for Windows tasks.

Keys Help
Displays descriptions of all the shortcut key combinations used in BookManager Library Reader for Windows.

About
Displays copyright and version information about the BookManager Library Reader for Windows application.
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3.4.2 Getting Contents Help

To get contents help, do one of the following:

) Press F1.
[ In windows that have a Help menu, choose the Contents command.
[ In dialog boxes, choose the Help button.

The Help window appears, describing the general purpose of the window for which you requested Help.
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3.4.3 Getting Context-Sensitive Help
Context-sensitive help is available for menu commands and for icons in the toolbar of the Book window.

To get context-sensitive help:

1. Click the Help icon

¥

using mouse button 1. The mouse pointer change s to:

¥

2. To get Help for a menu command, click the mouse pointer on the menu name to display the menu, then click the command you want
help for.

3. To get Help for an icon in the tool bar, click the icon.

The Help window appears, describing the purpose of the specific item for which you requested Help.

To redisplay the regular mouse pointer press Esc.
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3.4.4 Getting Short Help

Short help--a one-sentence description--is available for each icon in the tool bar of the Book window and for all menu commands. The
short help appears in the status bar of the window in which you request it.

To get short help for a menu command:

[1 Select the menu command.
A one-sentence description of the item appears in the status bar, and remains there as long as the menu command is selected.
TIP: Holding the mouse button down and dragging the mouse pointer slowly across all the commands in a menu--or using the Up Arrow

or Down Arrow keys to move the selection cursor from one menu command to the next--displays all the short help descriptions one
after another in the status bar.

To get short help for icons in the tool bar of the Book window:

1 Move the mouse pointer onto the icon in the tool bar, but don't click.

The short help appears in the status bar, and remains there as long as you keep the mouse pointer positioned on the icon.

TIP: Move the mouse pointer slowly across the entire tool bar to display all the short help descriptions one after another in the status bar.
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4.0 Starting BookManager Library Reader for Windows
You can start BookManager Library Reader for Windows in several ways. This chapter describes how to start from Microsoft Windows
Program Manager.

Subtopics

4.1 Starting from Program Manager

4.2 The List of Bookshelves

4.3 The List of Bookcases

4.4 Listing Books That Reside on Different Directories
4.5 Startup Options

1 Copyright IBM Corp. 1989, 1994
40-1



BookManager Library Reader for Windows: User's Guid e
Starting from Program Manager
4.1 Starting from Program Manager

To start BookManager Library Reader for Windows fro m Microsoft Windows
Program Manager:

[ In the active Program Manager window, choose the Library Reader for Windows program icon:

from the BookManager Library Reader for Windows group window.

The About dialog box for BookManager Library Reader for Windows appears briefly, and then the List of Bookshelves window appears.
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The List of Bookshelves

The List of Bookshelves window appears every time you choose the Library Reader for Windows icon. It contains a list of the different
bookshelves you have. The bookshelves listed are those that Library Reader for Windows has found in the startup path.

Figure 1 is a sample List of Bookshelves:

= Hoo ANAQE of [ 1l miile -
File VYiew Options Window Help
Mame Date Title
HH 11 i A i H HEAD fo d o Bl E atic

-

ForHelp. press F1

-

Total Bookshelses: 1

Figure 1. List of Bookshelves Window

The parts of the List of Bookshelves window are:
1 Title Bar

2 Menu Bar

3 Bookshelf Icon
Represents an unopened bookshelf.

4 Name
The file name of the bookshelf. It is assigned by the person who created the bookshelf.

5 Date
Date and time that the bookshelf was created or last changed.

6 Title
Title of the bookshelf, also assigned by the bookshelf creator.

7 Split Bar
Divides the titles from the other bookshelf information. Drag the split bar left or right to adjust the size of the panes in the
window. To save the location of your split bar, choose Options/Save Window .

8 Vertical Scroll Bar
Used to move forward or backward through the list of bookshelves. Information in both halves of the window scrolls
concurrently.

9 10 Horizontal Scroll Bars
Used to bring hidden information on a line into view. The two horizontal scroll bars work independently of each other.

11 Status Bar
Displays information about the contents of the List of Bookshelves. Also displays short help for a menu command when you
select that command.

To control whether the status bar appears in the List of Bookshelves window, choose View/Status Bar .

Subtopics

4.2.1 Getting Descriptions of Bookshelves

4.2.2 Changing or Sorting the List of Bookshelves
4.2.3 Creating a Different List of Bookshelves

4.2.4

Saving Window Size, Position and Sort Order
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4.2.1 Getting Descriptions of Bookshelves

You can find out more about your bookshelves by bringing up a bookshelf description. A bookshelf description is a dialog box that gives
you detailed information about a Library Reader for Windows bookshelf, such as how many books are on the shelf, when it was created,
whether it has a search index, and what its path and file name is.

To get a bookshelf description:

[ From the File menu of the List of Bookshelves window, choose Bookshelf Description

The Bookshelf Description dialog box appears. Figure 2 shows a sample Bookshelf Description dialog box:

= Bookshelf Description

Bookshelf Title:

|FIEAD for Windows D ocumentation

Bookshelf Name: EJREBS MO0

Search Index:

EJRBSHOO

Total Books: |3

Urindexed Books: |[|

Date Created: |B;"| 794 7:16:33PH

Your Access: |FEEAD oMLY

File Name:
D-5\BOOKSAEJRESHM OO0 BES

Figure 2. Bookshelf Description dialog box

The bookshelf description consists of:

Bookshelf Title
The title of the bookshelf entered when the bookshelf was created using BookManager Library Reader for Windows or another
BookManager READ product.

Bookshelf Name
The the name assigned by the creator of the bookshelf, or else the default name that BookManager Library Reader for Windows
assigns.

Search Index
The file name of the bookshelf search index file, if it has one. No file extension is displayed, because the file always has an
extension of .BKI. No path is displayed because the file must be located either in a directory named in your startup path or else
in the same directory as the bookshelf file.

Total Books
The total number of books that have been added to this bookshelf.

Unindexed Books
The number of books in this bookshelf whose contents are not included in the bookshelf search index.

Unindexed books are books that were added to the bookshelf after its search index had already been created.

Date Created
The date and time that the bookshelf was created or modified using BookManager Library Reader for Windows or another
BookManager READ product. The date displayed here may differ from the system date of the bookshelf file.

Your Access
Displays READ AND WRITE if you can add books to the bookshelf as well as read them; displays READ ONLY when you can
only read the books in the bookshelf but not add new ones to it or remove any from it.
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File Name
The path file name, and file extension of the bookshelf's file.
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4.2.2 Changing or Sorting the List of Bookshelves

You can rearrange the list by:

[ Including bookshelves based on name, title, or whether they are selected (highlighted)
[ Sorting the list by name, title, or date

Subtopics

4.2.2.1 Including Selected Bookshelves in the List of Book shelves
4.2.2.2 Sorting the List of Bookshelves
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4.2.2.1 Including Selected Bookshelves in the List of Bookshelves

To include bookshelves by name:

1. From the View menu, choose Include>By Name
The Include by Name dialog box appears.

2. In the Name with Wildcards text box, type a full or partial bookshelf name up to 8 characters long. Don't type a file extension. For
example, type: ejrwind

[ Tolist all the bookshelves whose names begin with ejr, type ejr*.
The wildcard character, *, substitutes for any number of characters.

EXAMPLE
To list all bookshelves belonging to the BookManager Library Reader for Windows application, you would type ejr*

Capitalization does not matter; BookManager Library Reader for Windows ignores capitalization in this situation.

To find a bookshelf name containing a special character, type the special character exactly as it appears.

3. Choose OK.

The Include by Name dialog box closes, and the List of Bookshelves reappears listing only bookshelves whose names match what you
typed.

After you reduce the list to bookshelves that match a certain name, the complete List of Bookshelves is still available, though not visible.

TIP: Choose View/Include>By Name repeatedly, and BookManager Library Reader for Windows looks through the entire List of
Bookshelves each time, not just the visible list. You don't have to redisplay the entire list before including bookshelves by name again.

To include bookshelves by title:

1. From the View menu, choose Include>By Title
The Include by Title dialog box appears.

2. In the Title with Wildcards text box, type a full or partial word that occurs in the bookshelf title. You can find a word in the title, but not
a phrase.

EXAMPLES
To list all bookshelf titles dealing with BookManager READ products, type *read*

To list all bookshelves titles containing an imbedded slash, type */*

If you do not use wildcards, then the word you type must exactly match a word in the title except for capitalization. To find a word
containing punctuation, type the punctuation exactly as it appears in the title word.

3. Choose OK.

The Include by Title dialog box closes, and the List of Bookshelves reappears listing only bookshelves whose titles contain the word you
typed.

To include only the bookshelves you select:

1. In the List of Bookshelves window, select the bookshelf or bookshelves you want.
2. From the View menu, choose Include>Selected

The List of Bookshelves reappears, listing only the bookshelves you selected.

To include all bookshelves in the List of Bookshelv es again:

1. From the View menu, choose Include>All .

The List of Bookshelves reappears, now listing all the bookshelves it contained before it was reduced. If you selected bookshelves or
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sorted them prior to reducing the list, the selections and sort sequence are preserved.

TIP: Scrolling through the List of Bookshelves to select a number of different bookshelves can be time-consuming. Here's a faster way:

1. Choose Include>By Name or Include>By Title to reduce the list to just the ones you want to select.
2. Drag the mouse pointer over all of them to select them all.
3. Choose Include>All to redisplay the full list, and your selections will be nicely integrated into the full list.
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4.2.2.2 Sorting the List of Bookshelves
You can sort the list of bookshelves by name, date created, and title.

When the List of Bookshelves first appears, it is sorted by bookshelf name. All bookshelves in the list are sorted, even if some are
temporarily excluded from view. They stay sorted until you close the List of Bookshelves window, or sort the bookshelf again.

To sort the List of Bookshelves:

1. From the View menu, choose Sort.
The Sort cascading menu appears.

2. Choose one of the following menu commands:
) Name
L Date

[ Title

The List of Bookshelves reappears in the new sort sequence.
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4.2.3 Creating a Different List of Bookshelves

You might want to create a different List of Bookshelves if:

[ The List of Bookshelves is empty when you start Library Reader for Windows, which means that no books were found in your startup
path.

[1 The bookshelves in the list are not the ones you want, and there are bookshelves available to you in other directories.

To create a different List of Bookshelves:

[J From the File menu, choose List Bookshelves .

The List Bookshelves dialog box appears:

List Bookshelves...

File Hame: Directories:

* bks d-\books n
I = d:s
2= books

+

List Filex of Type: Dnves:

B ook shelves [’_hks]ﬂE d: work ﬂ !I

™ List Multiple Directones
Path:

D efaults

Figure 3. List Bookshelves Dialog Box
The parts of the List Bookshelves dialog box are:
1 Title Bar

2 Bookshelf Template 3 File Name
The bookshelf template (*.bks) indicates that when you open a directory, only the files with a file extension of .BKS will be listed in
the File Name list box ( 3). The template can't be changed, and the files can't be selected; they are listed only to confirm that
the directory does indeed contain bookshelves.

4 Directories
Displays the last directory to be accessed.

5 Available Directories

6 List Files of Type
Contains templates for the types of files that can be listed in the File Name list box ('3 ). In this window, only a bookshelf
template is available.

7 Drives

8 Path
Used to construct a list of several directories that together form the new temporary path that BookManager Library Reader for
Windows uses to create a new List of Bookshelves. Each time you open a directory and choose the Add button, that directory
is added to the Path list box.

Use the instructions in the following table to list bookshelves from different directories:
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directory you chose.

G S +
1 If you want to... | Do this... 1
+ S Gy 1
List bookshelves | 1. (Optional) From the Drives list box ( 7)1
from one directory | select the drive containing the new 1
i directory. 1
I I
I I
1 2. From the available dir ectories list box |
( 5), choose the new directory you want. |
I I
I I
i Bookshelf files appear in the File Name '
i1 list box ( 3 ). If no bookshelf files 1
| appear, then there wer e none in that '
i directory; choose anot her directory. i
I I
I I
1 3. Choose Ok. '
I I
I I
| The List of Bookshelve s window reappears, |
i listing the bookshelve s found in the '
|
I
I
I
I
I
I
I
I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

I

i

1 Note: Although it is not dimmed, the Ok |
1 button does not functi on if you chosea |

1 directory that contain s no bookshelves. |
+ S Gy 1

| List bookshelves | 1

| from several 1 1. (Optional) From the Drives list box ( 7)1
| directories not H select the drive containing the new 1

| already in your | directory. 1

| startup path ! 1

1 1 2. From the available dir ectories list box |

1 ( 5), choose the new directory you want. |

I I I

I I I

1 i Bookshelf files appear in the File Name '
1 i1 list box ( 3 ). If no bookshelf files 1

1 | appear, then there wer e none in that '

1 i directory; choose anot her directory. i

i | i

i | |

1 1 3. Choose Add. i

I I I

I I I

1 i The directory you chos e appears in the Path |
' 1 list box ( 8). H

I I I

I I I

1 | 4. Repeat steps 1 through 3 to choose as many |
1 | additional directories as you want. Each |
1 | time you choose Add, the directory name is |

1 | added to the Path list box. 1

I I I

I I I

1 1 5. (Optional) To remove a directory from the |
1 ' Path list box, select that directory, then |

1 ' choose Remove. 1

I I I

I I I

1 1 6. When all the directori es you want are 1

1 i listed in the Path list box, choose Ok. |
I I I

I I I

1 i The List of Bookshelve s window reappears, |
1 i listing all bookshelve s found in the '

1 I multiple directories y ou chose. '

+ S 1

| List bookshelves | 1. Choose Defaults . i

| from several i 1

| directories, some of |  The directories in you r startup path appear |
i which are already in| in the Path list box ( 8). 1

| your startup path | 1

1 1 2. (Optional) To remove an unwanted directory |
1 i from the Path list box, select that H
1 i directory, then choose Remove. 1

i | i

i | |

1 1 3. (Optional) From the Drives list box ( 7)1
1 ' select the drive containing the new 1

1 i directory. 1

I I I

I I I

1 1 4. From the available dir ectories list box |

1 o« 5), choose the new directory you want. |

I I I

I I I

1 i Bookshelf files appear in the File Name '
1 1 list box ( 3 ). If no bookshelf files 1

1 | appear, then there wer e none in that '

1 i directory; choose anot her directory. i

i | i

i | |

1 1 5. Choose Add. i
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I

I I

I I I

1 i The directory you chos e appears in the Path |
1 1 list box. 1

I I I

I I I

1 | 6. Repeat steps 3 through 5 to choose as many |

1 | additional directories as you want. Each |

1 | time you choose Add, the directory name is |

1 | added to the Path list box. 1

I I I

I I I

1 | 7. When all the directori es you want are 1

1 i listed in the Path list box, choose Ok. |
I I I

I I I

1 | The List of Bookshelve s window reappears, |

1 i listing all bookshelve s found in the '

1 | multiple directories y ou chose. '
G S +

The new List of Bookshelves you create using File/List Bookshelves is temporary--it lasts only until you exit the BookManager Library
Reader for Windows application, or choose the List Bookshelves or Refresh menu commands. To change the List of Bookshelves
permanently you must change your startup path.
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4.2.4 Saving Window Size, Position and Sort Order

You can save the size, location and sort order of the List of Bookshelves window so that the next time you start the application, the List of
Bookshelves assumes the same size and position in which you last left it.

To save the List of Bookshelves window size and pos ition:

[ From the List of Bookshelves, choose Options/Save Window .
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4.3 The List of Bookcases

The List of Bookcases appears when you choose the bookcase icon in the BookManager product group. The List of Bookcases contains
a list of the different bookcases. The bookcases listed are those that Library Reader for Windows has found in the startup path.

To open a bookcase in the list, double-click the bookcase icon.
Subtopics

4.3.1 Changing or Sorting the List of Bookcases
4.3.2 Saving Window Size, Position and Sort Order
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4.3.1 Changing or Sorting the List of Bookcases
You can rearrange the list by sorting the list by name, title, or date

Subtopics
4.3.1.1 Sorting the List of Bookcases
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4.3.1.1 Sorting the List of Bookcases
You can sort the list of bookcases by name, date last modified, and title.
When the List of Bookcases first appears, it is sorted by bookcase name. All bookcases in the list are sorted, even if some are temporarily
excluded from view. They stay sorted until you close the List of Bookcases window, or sort the bookcase again. To sort the List of
Bookcases:
1. From the View menu choose Sort

From the cascading menu, choose one of the following menu commands:

) Name

[ Title

[l Date

The List of Bookcases reappears in the new sort sequence.
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4.3.2 Saving Window Size, Position and Sort Order

You can save the size, location and sort order of the List of Bookcases window so that the next time you start the application, the List of
Bookcases assumes the same size and position in which you last left it.

. To save the List of Bookcases window size and position:

[ From the List of Bookcases, choose Options/Save Window .

Subtopics
4.3.2.1 Changing What is Listed in the List of Bookcases W indow
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4.3.2.1 Changing What is Listed in the List of Book cases Window
You list bookcases with titles that contain specific words or phrases by choosing View / Find Text

In the dialog box that appears, type the word or phrases contained in the titles you want listed, and choose OK The list reappears with the
titles containing the word or phrase you specified.

To list all the bookcases again, choose View / Refresh
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4.4 Listing Books That Reside on Different Director ies

When you start BookManager Library Reader for Windows, the List of Bookshelves or List of Bookcases appears. Instead of working
with books prearranged into bookshelves, you can create your own List of Books, which lists books that are in directories that you
specify. The books do not have to be in the same bookshelf, or in any bookshelf.

The new List of Books you create is temporary; it lasts only until you close it, or exit the BookManager Library Reader for Windows
application.

To create a List of Books:

[ Inthe List of Bookshelves or List of Bookcases window, choose File/List Books .
The List Books dialog box appears.

You use the List Books dialog box to create the List of Books window, just as you used the List Bookshelves dialog box to create a List of
Bookshelves.

Subtopics
4.4.1 Changing or Sorting the List of Books
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4.4.1 Changing or Sorting the List of Books

To change and sort the List of Books, choose View/Sort in the List of Books window.
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4.5 Startup Options

You can start BookManager Library Reader for Windows in different ways by using the READIBM or BOOKCASE command with
different startup options. For example, you can open a book directly to a topic 1D, or open a book and immediately start a search. To start
Library Reader for Windows using a startup option:

1. In Microsoft Windows Program Manager or File Manager, choose File/Run.

The Run dialog box appears.
2. In the Command Line text box, type READIBM followed by the startup option you want
3. Choose OK.

Subtopics
4.5.1 BOOKSHELF Startup Options
4.5.2 BOOKCASE Startup Options
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4.5.1 BOOKSHELF Startup Options

READIBM
Opens a List of Bookshelves containing bookshelves found in the default startup path.

READIBM shelfname-with-wildcards
Opens a List of Bookshelves containing bookshelves found in the default startup path whose names match the pattern established by the
wildcards.

Note: When you use this startup option to limit the contents of a List of Bookshelves, the View/Refresh menu command does not
restore any excluded bookshelves to the list. However, if instead you use wildcards from View/Include/By Name , then using the
View/Refresh menu command does restore the full list.

READIBM bookname
Opens the named book if found in the default startup path.

Note: If a bookshelf exists with the same name as the book, the bookshelf is opened instead of the book.

READIBM shelfname
Opens the named bookshelf if found in the default startup path.

Note: If the named bookshelf can't be found, but a book with the same name exists, the book is opened instead.

READIBM bookname /b
Opens the named book when both a bookshelf and a book in the default startup path share the same name.

READIBM shelfname /s
Opens the named bookshelf when both a bookshelf and a book in the default startup path share the same name.

READIBM bookname.BOO
Opens the named book if found in the default startup path.

READIBM shelfname.BKS
Opens the named bookshelf if found in the default startup path.

READIBM \path\bookname. BOO.
Opens the named book if found in the specified path and temporarily appends that path to the front of the startup path.

READIBM \path\shelfname .BKS
Opens the named bookshelf if found in the specified path and temporarily appends that path to the front of the startup path.

READIBM bookname /f search request
Opens the named book and searches for the words or phrases specified in the search request.

Note: If you do not type a search request, the Search Book or Search Book (Extended) dialog box appears.

READIBM shelfname /f search request
Opens the named bookshelf and searches for the words or phrases specified in the search request

Note: If you do not type a search request, the Search Multiple Books or Search Multiple Books (Extended) dialog box appears.

READIBM bookname /gt topiclD
Opens the named book to the topic ID specified.

READIBM bookname /p
Opens the named book and prints the entire book.
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4.5.2 BOOKCASE Startup Options

BOOKCASE
Opens a List of Bookcases window containing bookcases found in the default startup path.

BOOKCASE shelfname-with-wildcards
Opens a List of Bookcases window containing bookcases found in the default startup path whose names match the pattern established
by the wildcards.

Note: When you use this startup option to limit the contents of a List of Bookcases, the View/Refresh menu command does not restore
any excluded bookshelves to the list.

BOOKCASE bookname /b
Opens the named book when a bookcase, bookshelf and/or book in the startup paths share the same name.

BOOKCASE shelfname/s
Opens the named bookshelf when a bookshelf, bookcase, and/or book in the startup paths share the same name.

BOOKCASE bookname.BOO
Opens the named book if found in the default startup path.

BOOKCASE shelfname.BKS
Opens the named bookshelf if found in the default startup path.

BOOKCASE casename.BKC
Opens the named bookshelf if found in the default startup path.

BOOKCASE \path\bookname. BOO.
Opens the named book if found in the specified path and temporarily appends that path to the front of the startup path.

BOOKCASE \path\shelfname .BKS
Opens the named bookshelf if found in the specified path and temporarily appends that path to the front of the startup path.

BOOKCASE \path\ casename.BKS
Opens the named bookcase if found in the specified path and temporarily appends that path to the front of the bookcase startup path.

BOOKCASE bookname /f search request
Opens the named book and searches for the words or phrases specified in the search request.

Note: If you do not type a search request, the Search Book or Search Book (Extended) dialog box appears.

BOOKCASE casename /| search request
Opens the named bookcase and displayes the bookcases and bookshelves that have a specified word or phrase in the title or name.

BOOKCASE shelfname /f search request
Opens the named bookshelf and searches for the words or phrases specified in the search request

Note: If you do not type a search request, the Search Multiple Books or Search Multiple Books (Extended) dialog box appears.

BOOKCASE bookname /gt topiclD
Opens the named book to the topic ID specified.

BOOKCASE bookname /p
Opens the named book and prints the entire book.

BOOKCASE casename-with-wildcards
Opens a List of Bookcases containing bookcases found in the bookcase startup path whose names matchthe pattern established by
the wildcards.

BOOKCASE casename-with-wildcards /I search request
Opens the List of Bookcases window displaying the bookcases and bookshelves that have the specified word or phrase in their titles.

BOOKCASE casename /c
Opens the named bookcase when a bookcase, bookshelf, and/or book in the startup paths share the same name.

BOOKCASE \path\casename-with-wildcard.BKC
Opens the List of Bookcases with these matching bookcases listed.

1 Copyright IBM Corp. 1989, 1994
452-1



BookManager Library Reader for Windows: User's Guid e
Opening a Bookcase
5.0 Opening a Bookcase
To "open a bookcase" means to display a window that lists the names of the bookshelves and nested bookcases contained in the
bookcase.

Subtopics
5.1 Opening a Bookcase from the Product Window
5.2 Opening a Bookcase with a Menu Command
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5.1 Opening a Bookcase from the Product Window

To open a bookcase, choose the icon for the bookcase from the List of Bookcases.
The Bookcase window appears, listing the contents of the bookcase you chose. The bookcase icon changes to an open bookcase.
The bookcase window displays the following information:

[1 Bookshelf or nested bookcase icon

[J The name of the bookshelf or nested bookcase, assigned by the person who created the bookshelf or nested bookcase
[ The descriptive title of the bookshelf or nested bookcase
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5.2 Opening a Bookcase with a Menu Command
To open a bookcase using a menu command:

1. From the File pulldown in the List of Bookcases, choose Open > Bookcase

An Open Bookcase dialog box similar to a typical Windows Open dialog box appears, which you can use to open a bookcase file
located in any directory to which you have access.

2. In the Open Bookcase dialog box, select the drive, directory, and file from the ones listed in the list boxes; the default selection is the
first directory in your startup path or the last directory you used.

You use this dialog box the same way you use other Open dialog boxes in other applications for the Windows operating system; here,
however, you can open only bookcase files, which have file extensions of .BKC.

When you open a bookcase from the Open Bookcase dialog box, the Bookcase window appears.

Subtopics

5.2.1 Changing or Sorting the Bookcase

5.2.2 Changing the Contents of the Bookcase Window
5.2.3 Getting a Description of a Nested Bookcase

1 Copyright IBM Corp. 1989, 1994
52-1



BookManager Library Reader for Windows: User's Guid e
Changing or Sorting the Bookcase

5.2.1 Changing or Sorting the Bookcase

When you open a bookcase, it initially lists all bookshelves and nested bookcases it contains. The list might be more than you need or
might not be arranged in a sequence that suits the task at hand.

Choose View/Sort to sort the bookcase contents by name, or title.
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5.2.2 Changing the Contents of the Bookcase Window
To change the contents of the Bookcase window:
1. Choose View / Find Text

2. In the dialog box that appears, enter the word or phrase that you want to find in the titles or names of the bookshelves or nested
bookcases in the bookcase. You can use wildcards in the phrase.

Matches are found within nested bookcases and are displayed.
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5.2.3 Getting a Description of a Nested Bookcase

1. In the Bookcase window, select the nested bookcase whose description you want to see.

2. From the File menu, choose Modify

3. At the top of the dialog box that appears is the fully qualified path, title, file name, and so forth for the bookcase.

4. If you do not want to make any changes or modifications, click Done to close the dialog box.
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6.0 Opening a Bookshelf
To "open a bookshelf" means to display a window that lists the names of the books contained in that bookshelf.

Subtopics
6.1 Opening a Bookshelf from the List of Bookshelves
6.2 Opening a Bookshelf with a Menu Command
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6.1 Opening a Bookshelf from the List of Bookshelve S

To open a bookshelf from the List of Bookshelves:

[1 Choose the icon for the bookshelf:

The Bookshelf window appears, listing the contents of the bookshelf you chose, and the Bookshelf icon changes to:

Figure 4 shows a sample Bookshelf:

! BookManager READ for ¥indows Hookshelf - READ for Windows Documentation

_Eile Edit View Search Options Window Help B

MName Date Title

% EJRW2MO00D 811794 710:42PM  [BookManager User's Guide SC34-3056-

% EJRW3MO0D  8/1/94 3:40:00PM  ([BookManager Online Reference 5G34-3057-
% EJRYWEMOD 27194 12:23:15AM [BookManager Quick Heference SC34-3058-
3] 4 6|

«| | m |:I|*| | -

ForHelp, press Fl E Watal Books. 3

Figure 4. Bookshelf Window

The parts of the Bookshelf window are:
1 Title Bar

2 Menu Bar

3 Book Icon
Represents an unopened book.

4 Name
Book file name, assigned by the person who created the book using BookManager BUILD.

5 Date
Date and time that the book was created using BookManager BUILD.

6 Title

7 Document Number
Document number of the book, assigned by the author.

8 Split Bar
9 Vertical Scroll Bar

10 11 Horizontal Scroll Bars
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12 Status Bar

Subtopics
6.1.1 Opening the Same Bookshelf Again
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6.1.1 Opening the Same Bookshelf Again
There might be times when you want to open two or more Bookshelf windows that list the contents of the same bookshelf. Perhaps you

need to sort the two lists differently and compare them side-by-side, or perhaps you want to display the complete list in one window while
including only a subset of the list in the other.

To open another Bookshelf window for a bookshelf op ened from the List of
Bookshelves:

1. Inthe List of Bookshelves, select the line for the opened bookshelf:

2. From the File menu, choose Open Again .

Another Bookshelf window appears, listing the contents of the same bookshelf. The Bookshelf windows work independently, letting you
work with the lists differently in each.
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6.2 Opening a Bookshelf with a Menu Command

To open a bookshelf using a menu command:

1. From the List of Bookshelves, choose File/Open Bookshelf .

An Open Bookshelf dialog box similar to a typical Windows Open dialog box appears, which you can use to open a bookshelf file located
in any directory to which you have access.

2. In the Open Bookshelf dialog box, select the drive, directory, and file from the ones listed in the list boxes; the default selection is the
first directory in your startup path or the last directory you used.

You use this dialog box the same way you use other Open dialog boxes in other applications for the Windows operating system; here,
however, you can open only bookshelf files, which have file extensions of .BKS.

When you open a bookshelf from the Open Bookshelf dialog box, the BookManager Library Reader for Windows Bookshelf window
appears.

To get a book description:

1. From a Bookshelf window or a List of Books, select the book whose description you want to see.

2. From the File menu, choose Book Description .

Note: In the Bookshelf window or List of Books, Book Description is dimmed if you have selected more than one book.

The Book Description dialog box appears. Figure 5 shows a sample Book Description dialog box:

= Book Description

Book Title:
|IBH BookManager HEAD for Windows[TH]: Quick Reference
Copyright or Securitp Classification:
|' Copynght IBM Corp. 1389, 1994
Document Number:
|5C34-3058-00
Authors:
o

Date Published: ‘Sep[embEI 1994

Date Built: ‘ 875794 3:05:25PM

Yersion of ‘]_3_0

File Hame:
D-ABOOKSAEJRWSMO0. BOD

Figure 5. Book Description dialog box

To be sure that you are seeing all the information in a text box, move the insertion point into the box and either scroll or press End.
The book description consists of:

Book Title

Copyright or Security Classification
The author-assigned security classification if the book has one, or its copyright information.

Document Number
The author-assigned document number if the book has one, or the book's file name.
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Authors
All author names or author information that the book contains.

Date Published
The author-assigned publication date.

Date Built
The date and time that the book was created using BookManager BUILD.

Note: The build date recorded for the book in the bookshelf file might not match this Date Built , which is stored in the book file,
if the book was rebuilt after having been added to the bookshelf. If the date or other book information, such as title, doesn't
match the information in the bookshelf, then BookManager Library Reader for Windows displays a warning message in the
Bookshelf window status bar when you choose display the book description.

Version of BUILD
The version and release level of the BookManager BUILD product used to create the book, for example 1.2.

File Name
The path, file name, and file extension of the book's file. The path reflects where the book file that is the source of this book
description information is located.

Subtopics
6.2.1 Changing or Sorting the Bookshelf
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6.2.1 Changing or Sorting the Bookshelf

Choose View/Sort To change your view of the bookshelf contents temporarily, without actually removing or adding books.
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7.0 Opening a Book
To "open a book" means to display a window containing the book text so that you can read it. When you open a book, you can read it,
search it, and make notes in it.

Three of the most common ways to open a book are:

From a Bookshelf window or a List of Books window
From the List of Bookshelves window

From the Book window

From the List of Bookcases window

I

Subtopics

7.1 Opening a Book from a List of Bookcases, Bookshelf or List of Books

7.2 The Book Window

7.3 Opening a Book from the List of Bookshelves, List of Bookcases, or Book Window
7.4 Opening the Same Book Again
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7.1 Opening a Book from a List of Bookcases, Booksh elf or List of Books

To open a book from the Bookshelf window or List of Books window:

[1 Choose the icon for the book: (3)

A Book window appears, displaying the text of the book you chose.

(3) Although it is possible to select more than one book in this window, pressing Enter when multiple books are highlighted opens only the
book that has the selection cursor.
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7.2 The Book Window

The Book window displays the text of a book one topic at a time. The book title is shown in the window title bar.

When you first open a softcopy book that doesn't have any bookmarks placed, the book opens to the first topic, typically the cover or title
page if it has one. In some books, the Table of Contents is the first topic. Books that have nothing but text open directly to the beginning of

the text.

Subtopics
7.2.1 Understanding the Tool Bar
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7.2.1 Understanding the Tool Bar

The tool bar appears at the top of a Book window, just below the menu bar. Each icon it contains represents a specific menu command.
Figure 6 shows the tool bar:

i BookManager BEAD for Windows Book - BookManager READ for Windows: Quick Hefdhd IS

File Edit VYiew Mavigate Search MNotes Options Window Help

D) Bl [ A7 18 he

Figure 6. Tool Bar
Here's what the icons on the tool bar mean:

Icon Description

Search the book
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Create a new note

Display the notes list

o

Gets context-sensitive help for the n ext menu command the or
icon in the tool bar that you click o n in the Book window

Note: You can't use the keyboard to work with the tool bar; using it requires a mouse.

To hide the tool bar temporarily on a specific Book window:

[ From the View menu of that window, choose (check mark)Tool Bar

The tool bar disappears and the menu command is no longer checked. To redisplay the tool bar, choose the same menu command
again.

To hide the tool bar permanently on all Book window S:

1. From the Options menu, choose Workspace .

2. In the Options - Workspace dialog box, clear the check box labeled Show Tool Bar .
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3. Choose OK.

Changing this option does not affect any Book windows already open, only Book windows that you open in the future.
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7.3 Opening a Book from the List of Bookshelves, Li st of Bookcases, or Book Window
To open a book from the List of Bookshelves, List o f Bookcases, or Book
window:

[ In the List of Bookshelves, choose File/Open Book
[ In the Book window, choose File/Open
[ In the List of Bookcases, choose File / Open Book

An Open Book dialog box similar to a typical Open dialog box in the Windows operating system appears. You can use it to open a book file
located in any directory to which you have access. You select the drive, directory, and file from the ones listed in the list boxes. The
default selection is the first directory in your startup path or the last directory you used. In BookManager Library Reader for Windows you
can open only book files--files with a file extension of .BOO.

When you open a book from the List of Bookshelves or List of Bookcases, a new Book window appears. When you open a book from the
Book window, the book currently open closes and is replaced by the new book.
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7.4 Opening the Same Book Again

You might at some point want to open two or more windows displaying the same book so that you could, for example, compare different
topics in the book at the same time, or use one window to view a figure and another window to view text.

To open an additional Book window:

1. In the Bookshelf window or List of Bookshelves, select the icon for the opened book:

2. From the File menu, choose Open Again .
Another Book window appears, displaying the same book. The Book windows work independently, letting you display different portions

of the book in each.

Subtopics
7.4.1 Listing and Closing Windows
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7.4.1 Listing and Closing Windows
You can check to see what Book, Bookshelf, and Bookcase windows you currently have opened by choosing the Window menu.

Up to nine windows are listed in the order in which they were opened. If more than nine are currently open, the menu contains the More
Windows command; choosing it opens a separate list of all the open Bookcase, Bookshelf, and Book windows.

To view a list of windows opened:

[1 Choose the Window menu.

The menu opens, listing all currently open bookshelf and book windows that were opened the window you are in.

To go to a window opened:

1. Choose the Window menu.

The menu opens, listing all currently open bookshelf and book windows.
2. Choose the line for the window you want.

The window appears and becomes active.

To close all windows opened:

[l From the Window menu, choose Close All .
The windows listed in the Window menu close, but the window you are in remains open.
The format of the entries in the window list differs slightly depending on how you opened the windows:
[1 Bookshelves that you opened by double-clicking on them in the List of Bookshelves are represented by bookshelf name:bookshelf title.
[1 Bookcases that you opened by double-clicking on them in the List of Bookcases are represented by bookcase name:bookcase title.
[1 Bookcases, bookshelves or books that you opened using the Open Bookcase , Open Bookshelf or Open Book menu commands

are represented by the word BOOKCASE, BOOKSHELF or BOOK followed by the path and file name of the bookcase, bookshelf or
book file.
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8.0 Reading a Book
This chapter introduces you to finding your way through a softcopy book that was created using BookManager BUILD.

You read the text in a softcopy book the same way that you read any printed book, but instead of turning pages, you scroll through the topic
text. One big advantage of reading softcopy is that you can easily skip from place to place, reading only the topics or paragraphs that
interest you.

Subtopics

8.1 Reading a Book Sequentially
8.2 Finding the Topic You Want
8.3 Linking to Other Information
8.4 Viewing Footnotes

8.5 Viewing Pictures
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8.1 Reading a Book Sequentially
The easiest way to read your softcopy book is to just scroll through each topic, and then choose a different topic.

To go to a different topic:

[1 Choose the Go to Next Topic or Go to Previous Topic menu commands, or the toolbar icons,

When you are reading a book whose topic text reflows to fit the window, you usually do not need to scroll left or right to view text. Some
information, however, such as tables, does not reflow, and you might need to scroll left or right to view them completely.
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8.2 Finding the Topic You Want

In a softcopy book, you can quickly move from topic to topic using the menu commands or tool bar. This section describes how to identify
and go to specific topics that you're interested in.

Subtopics

8.2.1 Choosing a Topic from the Topics Navigator
8.2.2 Choosing a Topic from the Table of Contents
8.2.3 Going to a Specific Topic ID

8.2.4 Going to a Topic from the Index

8.2.5 Finding Topics That Have Been Revised
8.2.6 Finding Figures

8.2.7 Finding Tables

8.2.8 Returning to Topics You've Already Viewed
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8.2.1 Choosing a Topic from the Topics Navigator

You can choose a specific topic to view from the Topics navigator, which is located to the right of your topic text. The Topics navigator
lists the topics in the book in the order in which they occur.

The Topics navigator is always part of the Book window, but can also be in a separate window.

To display the Topics navigator in a separate windo w for the book you are
currently reading, do one of the following:

[J From the tool bar, choose

[ From the Navigate menu, choose By Topics .

Even when the Topics navigator appears in a separate window, it also remains as part of the Book window. If you don't need it in both
places, drag the split bar in the Book window to the right to cover the navigator and expose the maximum amount of topic text.

When it is in a separate window, the Topics navigator always stays on top of the Book window even when you make the Book window
active. This way you can move it out of the way when you're not working with it.

In a Book window with a Topics navigator, to change the side that is
active:

[J Click with mouse button 1 or press F6
The topic text side of the window must be active for you to mark text; the Topics navigator side must be active for you to choose a topic.
W hether the Topics navigator is part of the Book window or in a separate window, you list and hide subtopics the same way:

To list or hide the subtopics of one topic:

1 Choose the Expand icon next to the topic ID to list subtopics
1 Choose the Collapse icon next to the topic ID to hide the subtopics.

To list or hide subtopics of all topics:

[ From the Topics navigator or the Book window, choose View/Expand All or View/Collapse All .

To open a topic from the Topics navigator:

[ Scroll the list to the topic you want to read, and choose it.
The Book window becomes active and displays the beginning of that topic.

The Topics navigator lists the same topics as the t able of contents, if
your book has a table of contents.

The Topics navigator is not the same as a book's table of contents topic. Here are the differences:
[ You always have a Topics navigator, even if the book you're reading does not have a table of contents.
[ You can expand or collapse the topics listed in the the Topics navigator, but not in the table of contents.

[ You can select topics for printing from the Topics navigator, but not from the table of contents.

You can't scroll the topic text by scrolling the Topics navigator. You must choose a specific topic in the navigator.

To make the Topics navigator in the Book window vis ible or larger:

1. Drag the split bar in the Book window to the left.

2. (Optional) To have BookManager Library Reader for Windows remember your preference for the split bar location, choose Save
Window from the Options menu.
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To set the Topics navigator to always appear in a s eparate window for all
books that you open in the future:

1. From the Options menu of the book you are reading, choose Workspace .
2. In the Options - Workspace dialog box, select the check box labeled List Topics in Separate Window
3. Choose OK.

Every book you open from now on will display its Topics navigator in a separate window.

1 Copyright IBM Corp. 1989, 1994
8.21-2



BookManager Library Reader for Windows: User's Guid e
Choosing a Topic from the Table of Contents

8.2.2 Choosing a Topic from the Table of Contents

In a BookManager book, a table of contents is optional--it exists only if the author created one. If it exists, you can find it in a topic whose
topic ID is typically CONTENTS. This, too, can be changed by the author.

The text in the table of contents topic does not reflow.

To open a topic by using the table of contents:

[ From the table of contents topic in the Book window, choose the topic you want to read.
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8.2.3 Going to a Specific Topic ID
If you know the topic ID of the topic you want to read, you can go right to it by choosing a menu command.
Topic IDs are usually numbers, such as 2.3 for example, but they can also be nonnumeric, descriptive names. Authors can create any

topic IDs they want. When topic IDs are not specifically created by an author, BookManager BUILD generates them automatically. Table
1 lists some common descriptive topic IDs typically used in BookManager books:

o +
| Table 1. Nonnumeric Topic IDs Found in Softcopy 1

o e :

1 ABSTRACT | Summary of a book 1

+ Bt H

1 APPENDIX | Supplementary material at the end of a book |
+ Bt H

| CONTENTS | Table of contents 1

+ Bt H

1 COVER | Cover page of a book 1

+ Bt H

| FIGURES | List of figures in a book 1

+ Bt H

| FIRST | First topic in the book 1

+ Bt H

| FRONT | Front matter in a book (may be follo wed by |
1 i a number if there are several front matter |
' | topics) '

+ Bt H

| GLOSSARY | List of terms with definitions 1

+ Bt H

1 INDEX i Alphabetical list of subjects 1

+ Bt H

| LAST | Last topic in the book 1

+ Bt H

i NOTICES | Announcements, copyright, and tradem ark |

1 | information 1

+ Bt H

| PREFACE | Introductory text of a book 1

+ Bt H

| SAFETY | Safety notices in a book 1

+ Bt H

| SECURITY | Security notices in a book 1

+ Bt H

I SYNOPSIS | Summary or brief outline of a book 1

+ Bt H

| TABLES | List of tables in a book 1

+ Bt H

| TITLE | Title page of a book 1

+ Bt H

i VERSION | Information about the version of a b ook |
e e :

i Note: Not all softcopy books have these topic IDs, and 1
| a book may have many other topic IDs not found in this |

| list. '
e +

To go to a topic if you know the topic ID:

1. From the Navigate menu, choose Go to Topic ID .
The Go to Topic ID dialog box appears.
2. Type the topic ID of the topic you want to go to.
EXAMPLE
To go to topic 2.3, type 2.3
To go to the index, type INDEX
To go to the first topic in the book, type FIRST
3. Choose OK.

The Book window becomes active and displays the beginning of the topic you chose.
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8.2.4 Going to a Topic from the Index

An index is an alphabetical list of the subjects discussed in a book. If the author has created an index for the softcopy book, it is available
to you in the Index navigator. You can use the Index navigator to go to the topic containing the specific index entry.

To make the Index navigator visible:

[ From the Navigate menu, choose By Index .

The Index navigator window always stays on top of the Book window even when you make the Book window active. Move it out of the way
if it obscures what you want to view.

To go to a topic ID reference from the Index:

1. Scrall to the index section you want
2. Choose the index entry that interests you.
If the entry has several topic references, choose the specific topic you want. You can choose only one topic reference at a time.

The Book window becomes active and displays the beginning of the topic containing the index entry you chose.
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8.2.5 Finding Topics That Have Been Revised

Topics that the author has revised and identified with revision symbols are listed in the Revisions navigator. If the book has no revisions,
then the Revisions navigator is not available.

A revision symbol can be attached to a topic title in the book text or to a line of text. The Revisions navigator lists the topics containing
revision symbols; you must open a topic to view it.

To make the Revisions navigator visible, do one of the following:

[J From the tool bar, choose

1 From the Navigate menu, choose By Revisions .

To open a topic from the Revisions navigator:

1. Scrall the list to the topic containing the revisions you want to see.
2. Choose the topic.

The Book window becomes active and displays the beginning of the topic you chose.

Like the other navigators, the Revisions navigator window always stays on top of the Book window. Move it out of the way if you need to.

1 Copyright IBM Corp. 1989, 1994
8.25-1



BookManager Library Reader for Windows: User's Guid e
Finding Figures

8.2.6 Finding Figures

To go to a specific figure:

1 Choose Navigate/By Figures , and select the name of the figure you want to view from the list.
[ Or, in the book's Figures List topic, choose the hame of the figure you want to view.

A figures list topic exists only if the author created one. If it exists, the topic ID typically is FIGURES. This can be changed by the author,
however.

The figures list topic is not the same as the Figures navigator. The figures list is a topic that is displayed only in the side of the Book
window that displays topic text; the Figures navigator, on the other hand, is a separate window. You can use the Figures navigator to
keep the list of figures in front of you while you view the figures themselves in the Book window.
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8.2.7 Finding Tables

To go to a specific table:

[1 Choose Navigate/By Tables and select the name of the table you want to view from the list.
[ Or, in the book's Tables List topic, choose the name of the table you want to view.

The Book window becomes active and displays the table.

Note: The font used to display tables can affect whether the columnar information in the tables aligns correctly. A scalable, monospaced
font works best for displaying columnar text. You can change the font for columnar text by using the For Nonreflowable Text command
in the Options/Fonts menu of the Book window.

The Tables navigator window always stays on top of the Book window even when you make the Book window active. Move it if you need
to.
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8.2.8 Returning to Topics You've Already Viewed

Sometimes you might want to go back and reread a topic you have already seen. BookManager Library Reader for Windows keeps track
of the last 60 topics you read during the session and lists them for you in the Topics-Seen navigator, starting with the most recently
viewed topic at the top. From this navigator you can easily go to the topic you want to reread.

You can also use the Topics-Seen navigator to select one or more topics to print.

To make the Topics-Seen navigator visible, do one o f the following:

[J From the tool bar, choose

[ Or, choose Navigate/By Topics Seen .

To open a topic from the Topics-Seen navigator:

[ Scroll the list to the topic you want to return to, and choose it.

Subtopics
8.2.8.1 Clearing the Topics-Seen Navigator
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8.2.8.1 Clearing the Topics-Seen Navigator

The Topics-Seen list is cleared every time you exit BookManager Library Reader for Windows. You can erase the list yourself to start
accumulating a new one by choosing Edit/Clear in the Topics-Seen navigator.
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8.3 Linking to Other Information

Softcopy books usually have hypertext links that quickly take you to related information in another part of the same book, or to a different
book in the same bookshelf or List of Books.

Using a link is called linking, jumping, or "activating a link." The link can start from virtually anywhere in the text--a word, letter, phrase,
footnote symbol, or picture--and take you to other topic text, a footnote, figure, table, picture, another book in the bookshelf, or another
application.

BookManager Library Reader for Windows displays text links in a different color from ordinary text. You can change the color of text links
by choosing Options/Colors in the Book window.

Within a single book you can link to:

Topic titles

Table of contents entries

Pictures

Figures

Tables

List items

Footnotes

Glossary definitions for words (if any)
Index entries

ODooooooog

You can also link to:

1 Other books in the same bookshelf or List of Books
[ Other applications, for example a multimedia encyclopedia
[1 Message explanations (if any)

To link:

[ Double-click the emphasized word, phrase, footnote symbol, or icon using mouse button 1.

To link from one book to another, both books must be in the same bookshelf or List of Books, and the book you are linking from must have
been opened from within the bookshelf or List of Books rather than from Program Manager or File Manager.

Subtopics
8.3.1 When a Link Can Take You to Several Places
8.3.2 How Do | Get Back?
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8.3.1 When a Link Can Take You to Several Places

If you use a link that has multiple destinations, or targets, you don't automatically go directly to one of the targets. Instead, the targets are
listed for you in the Choose a Link dialog box so you can choose where to go.

To complete a link when there are multiple destinat ions:

[1 From the Available Links list box, choose the link destination you want.

To cancel a link when there are multiple destinatio ns:

[1 From the Available Links list box, choose Cancel.
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8.3.2 How Do | Get Back?

Getting back to where you started before you linked depends on whether you linked to text within the same book or to a picture, an
application, or a different book.

To get back from within the same book:

[J From the tool bar, choose

[ Or, from the Navigate menu, choose Go to Previous Link .

TIP: Repeatedly choosing the Previous Link icon retraces your path in reverse order through all the links you used.

To get back from a picture, application or another book, do one of the
following:

[ Close the picture, application, or new book window that was opened.

When you close the Library Reader for Windows book or picture that you linked to, the original Book window that you linked from
becomes active.

When you close an application that you linked to:
- Program Manager becomes active if you are running from Microsoft Windows or a full-screen WIN-OS/2 session
- The OS/2 desktop becomes active if you are running from a WIN-OS/2 window.

[ Leave the new window open, and select your original Book window to make it active again.
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8.4 Viewing Footnotes
You can view a footnote in two ways:

[1 By linking to the footnote text from the footnote symbol, a number or character enclosed in parentheses

[ By scrolling to the end of the topic, where all footnotes for that topic are displayed

To view a footnote by linking to it, either:

[ Double-click the footnote symbol in the topic text, for example, (1), using mouse button 1.
[ Tab to the footnote symbol and press Enter.
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8.5 Viewing Pictures

Softcopy books created by BookManager BUILD can contain pictures, in the form of vector graphics or images, that you can view in one
of two ways:

[ In separate picture windows
[ Integrated (4) into the topic text

You control whether pictures appear in separate windows or integrated in topic text by choosing Options/Workspace and setting the
How to Show Pictures  option buttons on the Options - Workspace dialog box.

(4) Integrated pictures can be displayed best in books built with BookManager BUILD 1.3. In books built with BookManager BUILD 1.2,
pictures can be integrated, but are displayed with different and perhaps less than optimal results. Also, pictures specified as RUNIN
art cannot be integrated and will always display in separate windows.

Subtopics

8.5.1 When You Link to a Picture
8.5.2 The Picture Window

8.5.3 Viewing Integrated Pictures
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8.5.1 When You Link to a Picture

When pictures are not integrated in the topic text, the book contains a highlighted picture link where a picture would normally occur. Each
picture link appears on a line by itself. A picture link consists of the word PICTURE followed by either the picture number, for example:

PICTURE 41
or the picture name, for example,
PICTURE PICLINK

To display a picture by linking to it:

[ Double-click the picture link, for example, PICTURE 1 using mouse button 1.

[ Or, tab to the picture link to highlight it, and press Enter.

The picture appears in its own window.
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8.5.2 The Picture Window
You can open up to 10 pictures simultaneously, in 10 separate picture windows. The advantage of viewing a picture in its own window is
that you can manipulate the picture in one window (zoom in on it, for example) while simultaneously viewing the topic text in another

window.

To enlarge a picture to fill the window:

[1 Choose View/Size Picture to Window

To zoom in on a specific area of a picture:

1. Choose View/AutoZoom so that the checkmark appears ((check mark)AutoZoom ).

2. Press and hold mouse button 1. Drag from the upper left corner to the lower right corner of the area to be enlarged, then release the
mouse button.

The picture area you selected is enlarged.

TIP: Choosing (Checkmark)AutoZoom lets you do repeated enlargements on the same area more efficiently, selecting and enlarging the
area in one step.

You can zoom in on the same area repeatedly; the Zoom In menu command becomes unavailable when the picture cannot be enlarged
any further.

To undo a zoom in:

[1 Choose View/Zoom Out .

The most recent enlargement is undone.

TIP: If you have repeatedly zoomed in on a picture area, then repeatedly choose Zoom Out to undo the enlargements one by one.

To return an enlarged picture to its original size all at once:

[1 Choose View/Restore .

To copy a picture to the Clipboard:

[J Choose Edit/Copy .

When you copy a picture to the Clipboard, the entire picture in its original size is copied, even though you may have zoomed in on it or
reduced it to integrate it into topic text.
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8.5.3 Viewing Integrated Pictures

Instead of linking to a picture displayed in a separate window, you can view it integrated into the text.

BookManager Library Reader for Windows integrates a picture into topic text in one of three ways, depending upon the picture size:

[ If small enough, the entire picture is shown as is.

[ If the integrated picture is wider than the book window, use the horizontal scroll bar for text to view the hidden portions.

[ If the integrated picture is both wider and taller than the book window, the picture is reduced and placed into the text. You might need
to view these pictures in separate Picture windows to see them at their best.

Integrated pictures do not resize when you make the Book window smaller.

Subtopics
8.5.3.1 Viewing an Integrated Picture in a Separate Window
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8.5.3.1 Viewing an Integrated Picture in a Separate Window

A large picture that is reduced in order to be integrated into topic text can lose some of its detail. To show greater detail, view the picture in
a separate Picture window.

To view an integrated picture in a separate window:

[ Double-click the picture using mouse button 1.
[ Or, tab to the picture to highlight it, and press press Enter.

A Picture window appears, displaying the picture in its original form.

TIP: Lost your Picture window under a stack of other windows? Choose the integrated picture in the Book window again to make it visible
and active. Or, choose its title from the list of windows in the Window menu.
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9.0 Searching for Information
This chapter introduces you to searching for information in softcopy books using BookManager Library Reader for Windows.

Searching a single book is called a Book Search. Searching more than one book, on one bookshelf or across different shelves, is a
Multiple Book Search. You can do a simple search for a single word or phrase, or you can combine words and phrases using Boolean
operators to create precise searches that yield very specific results.

In User's Guide and Helps, we describe how to make fuzzy matches and use wildcard characters, Boolean operators, how to check for
search-word variations, and search for special symbols.

Subtopics

9.1 Searching One Book

9.2 Searching Multiple Books

9.3 Doing an Extended Search

9.4 Typing a Search Request

9.5 Doing More Complex Searches

9.6 Changing Search Options

9.7 Changing Search-Ranking Defaults
9.8 Viewing Search Results
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9.1 Searching One Book

To search a book for a single word or phrase:

1. Open the book you want to search.

2. From the tool bar, choose

or from the Search menu, choose Search Book
A dialog box called Search Book appears.

3. Type your search request--the words or phrases that you want to search for. To move the insertion point to a new line, press Enter.
You can also retrieve a previous search request by choosing the down arrow to the right of the Retrieve Previous Searches text box.

4. Choose Run Search .

BookManager Library Reader for Windows runs the search and displays the results either directly in the book text or in a list of topics
that you can choose from.

How your results are displayed depends on what options you have set.

Subtopics

9.1.1 Setting Options for Viewing Search Results

9.1.2 Getting from Match to Match

9.1.3 Searching for an Exact Word or Phrase in a Book
9.1.4 Searching for Fuzzy Matches

9.1.5 Using Wildcard Characters in a Search Request
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9.1.1 Setting Options for Viewing Search Results
You control how you want your search results displayed. You can either:
1 Godirectly to the text in the book that contains the search match

[ Display a list of topics that contain matches, and then choose the specific topic you want

The options that you set remain in place until you change them again.

To set an option for going directly to matches in t he text:

1. Open the book you want to search.

2. From the tool bar, choose

or from the Search menu, choose Search Book
3. In the Search Book dialog box, choose Extended .

The dialog box called Search Book (Extended) appears.
4. In the How to Show Results group, select Go to Matches in Book Text.
5. Choose Run Search.

When your search is complete, the Book window shows the text that contains the first match, which is highlighted.
The next time you do a search, you will be taken to the text containing the search matches.

To set an option for displaying a list of topics co ntaining matches:

1. Open the book you want to search.

2. From the tool bar, choose

or from the Search menu, choose Search Book
3. In the Search Book dialog box, choose Extended .

The dialog box, Search Book (Extended) appears.
4. In the How to Show Results group, select List Topics by Importance  or List Topics in Sequence.
5. Choose Run Search.

The dialog box called Search Book appears.

6. Double-click on the topic you want, and it appears in a Book window.

The next time you do a search, the matches will be displayed in this list of topics.
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9.1.2 Getting from Match to Match
When you view your search matches in the text, you can use the tool bar in the Book window to hop from match to match.

To go to the next search match:

[J From the tool bar, choose

or from the Search menu, choose Go to Next Match

The text containing the next search match appears. If a line contains more than one search match, BookManager Library Reader for
Windows goes to the first match on the line.

To go to the previous search match:

[J From the tool bar, choose

or from the Search menu, choose Go to Previous Match

To go to search matches in other topics:

1 From the Search menu of the Book window, choose Go to Next Topic Match or Go to Previous Topic Match

The beginning of the topic that contains search matches appears.
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9.1.3 Searching for an Exact Word or Phrase in a Bo ok

Finding exactly the same word or phrase that you type is one of the most useful kinds of searches you can do. An exact-match search
lets you locate a specific word with a precise spelling and capitalization, or a phrase that contains words in a particular sequence. You

can do an exact-match search only when searching a single book.

To do an exact-match search:

1. Open the book you want to search.

2. From the tool bar, choose

or from the Search menu, choose Search Book
The dialog box Search Book appears.
3. In the Search Book dialog box, choose Extended .
4. In the Search Book (Extended) window, from the Type of Search group, choose Exact Match .
5. Decide whether you want your search to match capitalization exactly, and select or clear the check box labeled Case-Sensitive .

6. Type your search request.

You can retrieve a previously used search request by choosing the down arrow at the right side of the Retrieve Previous Searches list
box.

7. Choose Run Search .

BookManager Library Reader for Windows runs the search and displays the results.
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9.1.4 Searching for Fuzzy Matches
When you are searching a single book, you can do a fuzzy-match search to find all occurrences of your search word in any form that

shares the same language root: plurals, forms with different endings, different verb forms including past or future tenses, and different
capitalization or punctuation.

If your search request includes a phrase, such as the white house , then a fuzzy-match search finds phrases that contain all the same
important words, even if they are not necessarily in the same order.

EXAMPLES
the white house matches the white house, white house, White House, and house that is white.

color matches color, colors, colored, coloring, and other forms of the word.
is matches is, am, are, and be.

Go. matches go. and go, as well as Gone! Ending your search word with a period followed by a space finds the word with any kind
of sentence-ending punctuation.

To do a fuzzy-match search:

[ In the Search Book (Extended) dialog box, select the check box Fuzzy Match in the Type of Search group. Then choose Run
Search.
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9.1.5 Using Wildcard Characters in a Search Request

Wildcards are special characters you can use in a search request to substitute for unknown letters in a word or unknown words in a
phrase. The wildcards you can use to substitute for letters are * and ?. The * wildcard can also be used to substitute for entire words in a
phrase.

To use the * wildcard:

[l Type the * at the beginning, middle, or end of your search word.
EXAMPLES
act* matches all words that begin with act, such as act, actor. and action.
*act matches all words that end with act, such as act, exact, and interact.
*act* matches words that have act in them, such as character.

To use the ? wildcard:

[ Use it the same way you use the *. Each ? stands for only one letter, however:
EXAMPLES
compute? matches words such as computer and computed, but not computers.
compute?? finds computers.

To use the * wildcard for one or more words in a ph rase:

[l Type the * in place of the unknown word in the phrase, placing a blank on either side of the *
In an exact match search, a single * wildcard can substitute for only one word in a phrase, but in a fuzzy search, it can stand for several
words.
EXAMPLES
actor * character matches phrases such as:

actor in character in either a fuzzy or exact search

actor stepping out of character only in a fuzzy search.
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9.2 Searching Multiple Books
In addition to searching just one book, you can also search several books simultaneously in multiple-book searches.
Subtopics

9.2.1 How Search Indexes Help
9.2.2 Searching Multiple Books
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9.2.1 How Search Indexes Help

Searching multiple books can take some time. If the books are listed in a search index, the search goes a bit faster. Library Reader for
Windows uses the search index to:

Increase the speed of the cross-book search

Rank search matches more accurately

Display variations for words in the search request

Search an entire bookshelf even when all its books are not available

I

A bookshelf often has a search index associated with it to enhance your searches. Icons for books listed in a bookshelf's search index
index. are different from the icons for books that are not in the index index.

A book is listed in a search index by the author when the book is created using one of the BookManager BUILD products.

1 Copyright IBM Corp. 1989, 1994
9.21-1



BookManager Library Reader for Windows: User's Guid e
Searching Multiple Books

9.2.2 Searching Multiple Books

To search multiple books concurrently:

1. Open a bookshelf, or create the List of Books you want to search.

2. To search specific books, select the books you want to search, and then choose Search/Selected Books Only
3. To search all books listed, choose Search/All Books Listed  in the Bookshelf window or List of Books window.
The Search Multiple Books dialog box appears.
The number following Number of Books to Search tells you how many books you will be searching.
4. Type or retrieve your search request.

5. Choose Run Search .

BookManager Library Reader for Windows runs the search and displays the results in a dialog box called Multiple-Book Search Results.
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9.3 Doing an Extended Search

When you search single books or multiple books, you can do an extended search to:

1 Check for variations of your search words

[ Use wildcard characters, Boolean operators, or other operators in your search request

1 Change the search options temporarily for the search you are about to do

The dialog boxes called Search Book (Extended) and Search Multiple Books (Extended) are virtually identical in appearance and usage,
except that the Search Multiple Books (Extended) contains no search options.

To do a search using an extended search dialog box:

1. Open the book or bookshelf you want to search.

2. From the Search Book or Search Multiple Books dialog box, choose Extended .

The Search Book (Extended) dialog box or Search Multiple Books (Extended) appears. If you typed a search request in the basic
search dialog box, it is preserved in the extended version.

3. Type or retrieve your search request.
You can type wildcard characters, or Boolean operators or other operators in your search request, or use command buttons to have
BookManager Library Reader for Windows enter them for you. See "Using Command Buttons to Enter Boolean Operators and
Symbols" in topic 9.3.1.

4. (Optional) Do a word check to check for variations of any word in your search request.

5. (Optional) In the Search Book dialog box, specify the type of search you want by changing yoursearch options . Options you change
in the Search Book (Extended) dialog box affect only the one book search you are about to do.

6. Choose Run Search .
BookManager Library Reader for Windows runs the search and displays the results.

(5) The setting of the check box labeled Use Only Extended Search Window , in the Options - Search Book or Options - Search Multiple
Books dialog box, controls which search dialog box appears when you begin a search. For information on changing this setting, see
"Always Using an Extended Search Dialog Box" in topic 9.3.2.

Subtopics
9.3.1 Using Command Buttons to Enter Boolean Operators a nd Symbols
9.3.2 Always Using an Extended Search Dialog Box
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9.3.1 Using Command Buttons to Enter Boolean Operat

Although you can type Boolean operators or other operators in your search request, in the extended search dialog boxes you can also

ors and Symbols

use command buttons to have BookManager Library Reader for Windows enter them for you.

Here's what the buttons at the right of the Search Request text box do:

G S +

| Table 2. Meanings of Search Operator Buttons H
G S i

i This button | Means | And does this H

+ + G S i

1 i AND | Inserts a space and & operator to the left |

1 ' | of the insertion point , or to the left of |

i PICTURE 47 | | the selected word or phrase. '
+ + G S i

1 i OR | lInserts a space and | operator to the left |

1 ' | of the insertion point or to the left of the |

i PICTURE 48 | | selected word or phrase. '
+ + G S i

1 i BUT | Inserts a space and ! operator to the left |

1 ' | of the insertion point or to the left of the |

i PICTURE 49 | | selected word or phrase. '
+ + G S i

1 | "as is" | Inserts two single quo tation marks around |}

1 | operator | the insertion point or on either side of the |

i PICTURE 50 | | selected word or phrase. Quotation marks |
1 ' | are only valid around Boolean operators or |
1 ' | other operators used i n search requests. |
+ + G S i

1 | grouping | Inserts left and right parentheses around |
1 | operators | the insertion point or on either side of the |

i PICTURE 51 | | selected word or phrase. Used toc hange the |
1 ' 1 order of precedence of Boolean operators, |

1 ' | meaning the order in w hich BookManager '
1 ' | Library Reader for Win dows processes Boolean |
1 ' | operators in a search request. 1

+ + G S i

1 | word or | Inserts a comma to the left of the insertion |

1 | phrase | point, or to the right of the selected word |

i PICTURE 52 | separator | or phrase. '
+ + G S i

1 i multiple | Inserts an asterisk to the left of the '

1 ' wildcard | insertion point, or to the right of the H

i PICTURE 53 | | selected word or phrase. '
+ + G S i

1 | single | Inserts a question mar k to the left of the |

1 ' wildcard | insertion point, or to the right of the H

i PICTURE 54 | | selected word or phrase. '
S S +

To use the & |,and ! operator buttons as you type:

1. Type aword in the search request.
2. Choose the Boolean operator button.

3. Type another word.

EXAMPLES
Type Jack

Choose

Type Jill .
You now have Jack & Jill.
To use the

& |, and

| operator buttons with marked text:
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1. In the search request, mark the word that will be on the right side of the operator.
2. Choose the Boolean operator button.

The Boolean operator appears to the left of the word you chose.

EXAMPLES
Type Jack Jill went up the hill

Mark the word Jill.

Choose

Mark the phrase went up the hill.

Choose

We 3

You now have Jack & Jill & went up the hill.

To use the " and () operator buttons as you type:

1. Type aword in the search request.

2. Choose the " or () button.

3. For quotation marks: type the symbol between them that you want to search for literally (see "Searching for Special Symbols" in topic
9.4.1).

For parentheses: type a phrase within them.

EXAMPLES
Type users

To make the " appear, choose

Press Right Arrow.
Type guide
You now have users"guide.

To use the " and () operator buttons with marked text:

1. In the search request, mark the symbol you want to enclose in quotation marks, or the phrase you want to enclose in parentheses.

Note: Even though the " button puts quotation marks around any marked text, quotation marks are valid only around Boolean operators
or other operators used in search requests. For more information, see "Searching for Special Symbols" in topic 9.4.1.

2. Choose the " or () button.

Quotation marks or parentheses appear around the marked text.
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EXAMPLES
Type Jack | Jill & went up the hill

Mark the phrase Jack | Jill.

Choose

Mark the phrase went up the hill.

Choose

We 3

You now have (Jack | Jill) & (went up the hill).

To use the *? and , operator buttons as you type:

1. Type aword in the search request.

2. Choose the * button, the ? button, or the , button.

EXAMPLES
Type Jack and Jill .

Choose

We 3

Type went up the hill .

Choose

You now have Jack and Jill, went up the hill?.

To use the *? and , operator buttons with marked text:

1. In the search request, mark the word you want the symbol to follow.
2. Choose the * button, the ? button, or the , button.

The symbol appears to the right of the word.

EXAMPLES
Type Jack and Jill went up the hill

Mark the word Jill.

Choose the

1 Copyright IBM Corp. 1989, 1994
9.31-3



BookManager Library Reader for Windows: User's Guid e
Using Command Buttons to Enter Boolean Operators and Symbols

Mark the phrase went up the hill.

Choose the

We 3

You now have Jack and Jill, went up the hill?.
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9.3.2 Always Using an Extended Search Dialog Box

If you find yourself always using an extended search dialog box because you change search options or do word checks frequently, or
because you like the convenience of using command buttons to insert operators into a search request, you can set a search option to
bypass either basic search dialog box and instead use only its extended search version.

To always use the Search Book (Extended) dialog box

1. From the Options menu choose the Searches command, then the Book command.
The Options - Search Book window appears.
2. In the Options - Search Book window, select the check box labeled Use Only Extended Search Window
3. Choose OK.
The Options - Search Book window closes. From now on, when you start a new book search, the Search Book (Extended) dialog box

appears instead of the Search Book dialog box.

To always use the Search Multiple Books (Extended) dialog box:

1. From the Options menu choose the Searches command, then the Bookshelf command.

The Options - Search Multiple Books window appears.
2. In the Options - Search Multiple Books window, select the check box labeled Use Only Extended Search Window
3. Choose OK.

The Options - Search Multiple Books window closes. From now on, when you start a new book search, the Search Multiple Books
(Extended) dialog box appears instead of the Search Multiple Books dialog box.
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9.4 Typing a Search Request

A search request consists of the word, phrase, or combination of words and phrases that you want to search for, including any wildcard
characters you use to make your search request more broad (that is, find more more search matches or any Boolean operators you use
to combine words and phrases to make your search more precise (that is, find fewer matches).

You type a search request into the Search Request text box on any of the following dialog boxes:

Search Book

Search Book (Extended)

Search Multiple Books

Search Multiple Books (Extended)

I

As you type a search request, press Enter whenever you want to type on a new line. You can type each each word or phrase on its own
line, or you can combine them on the same line, separated by a comma as shown in the following examples:

EXAMPLES
wall
Humpty Dumpty
sat, had a great fall

If you type a phrase (two or more words separated by spaces), each space in your search request matches any number of spaces in the
text, but does not match if punctuation intervenes.

EXAMPLES
white house matches white house and white house but does not match white: house or whitehouse

W hen you type two or more words or phrases on the same line separated by commas, BookManager Library Reader for Windows
interprets each comma as an "or." With the search request sat, had a great fall shown earlier, BookManager Library Reader for
Windows would consider a topic to have a match if it contained either the word sat or the phrase had a great fall.

Subtopics

9.4.1 Searching for Special Symbols

9.4.2 Search Request Limits and Restrictions

9.4.3 Checking the Book for Search Word Variations
9.4.4 Viewing Results for a Multiple-Book Search
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9.4.1 Searching for Special Symbols

The following symbols have special meaning in a BookManager Library Reader for Windows search request: &|! *? ,()and'. When
BookManager Library Reader for Windows encounters them in a search request, it interprets them not as symbols to be searched for,
but rather as symbols that are being used to substitute for letters or words in the search request, or to combine, group, or separate the
search words around them. Therefore, when you want to search for a word or phrase that contains one of these symbols, you must
enclose the symbol within single quotation marks in your search request. The exceptions are:

[ Whenthe &|and! characters are part of a word with no blanks around them, no quotation marks are needed.

[ The single quotation mark (') itself needs only one other quotation mark, not two.

EXAMPLES
To search for Jack & Jill type Jack ‘&' Jill in the search request. Without the single quotations around it, the & symbol would be

interpreted as a Boolean operator.

However, to search for C&O type C&O (no quotation marks are needed because the & is imbedded in the word).

To search for he came, he saw, he conquered type
he came’,' he saw',' he conquered in the search request.

To search for User's Guide type User"s Guide in the search request.
TIP: Instead of typing the single quotation marks, use the quotes (") button on the Search Book (Extended) or Search Multiple Books

(Extended) dialog box to have BookManager Library Reader for Windows put them around the character for you. See "Doing an
Extended Search" in topic 9.3.
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9.4.2 Search Request Limits and Restrictions

Here are some length limits to keep in mind as you type a search request:

G S +

| Table 3. Search Request  Length Limits '
G S 1

i Maximum number of characters in the search reques t, including | 255 |
i all words, phrases, and operators, as well as bla nks .

o Fommem H

i Maximum number of characters in any one word in t he search 1 60|
| request -

o Fommem H

| Maximum number of words in any one phrase | 64}

o Fommem H

i Maximum number of phrases in the search request | 64}
G S +

As for restrictions, there are only these:
[ You can't type a topic identifier (topic ID) in a search request.

In other words, you can't search for a topic 1D, although you can search for words that appear in topic titles or book titles. But topic IDs
are not part of the book text, and therefore BookManager Library Reader for Windows cannot search for them.

[1 To be found as a search match, words in a phrase must occur within two adjoining physical lines in the book text, even if they are in a
list.

EXAMPLE
In this fuzzy match search example, the phrase find this phrase would be found because all three words occur within two
adjoining lines of book text:

Library Reader for Windows has only two search rest rictions.

One of them is this :if you want Library Reader for Windows to find
a phrase , then all the words in the phrase have to be in tw o]

lines that follow each other, as in the lines of th is example.
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9.4.3 Checking the Book for Search Word Variations

To help you locate the exact words you are looking for, BookManager Library Reader for Windows can do a word check--that is, show
you a list of words already in the book that are similar in spelling to any word in your search request. You can then replace your search
word with a word from the list that has exactly the spelling you want.

When it does a word check, Library Reader for Windows looks only at words that exist in the book you are searching, or in the indexed
books on a bookshelf (if you are doing a cross-book search Therefore, the list of alternative words may not include all the possible
variations you might find in a dictionary.

Note: You can't do a word check if you are searching multiple books that are not on the same bookshelf, or if the bookshelf you are
searching does not have a search index associated with it.

To use word check:

1. In either of these dialog boxes:

[1 Search Book (Extended)
[ Search Multiple Books (Extended)

type (or retrieve) a search request in the Search Request text box.
2. Move the insertion point to the word you want to check.
3. Choose Word Check .

The Word Check dialog box appears.

4. In the Word Check dialog box, choose the word from the list that you want to replace your search word with. (If there is no alternative
word in the list that you want, choose Cancel .)

The Word Check dialog box closes. If you chose a new word, then it replaces your search word.

5. To do the search, choose Run Search .
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9.4.4 Viewing Results for a Multiple-Book Search
All the books that contain matches for your search request are listed in the Multiple-Book Search Results dialog box.

The Search Request text box displays the search request that was used in the cross-book search.

To view results from the Multiple-Book Search Resul ts dialog box:

1. Choose the title of the book you want.
W hat happens next depends on the settings of your book search options:
[ If Go to Matches in Book Text is your permanent setting, then the Book window displays the first search match in the topic text.

[ If either List Topics by Importance or List Topics in Sequence is your permanent setting, then a Search Results navigator
opens, listing the topics containing matches.

2. If a Search Results navigator opens, choose the match that you want to view.

The Multiple-Book Search Results dialog box remains open until you close it, so that you can explore search matches in as many books
as necessary.

When you close a book that was opened from the Multiple-Book Search Results dialog box, the dialog box becomes active again, ready
for your next selection.

To redisplay the Search Results navigator:

[J From the tool bar, choose

or from the Search menu, choose Display Search Results
The Search Results dialog box appears or, if already visible, becomes active.

To view the first search match of each topic along with the surrounding
words:

1. Choose View/Details .
Following each topic title, the line of text containing the first search match is displayed.

2. Toreturn to viewing only the topic titles, choose View/Topics Only .
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9.5 Doing More Complex Searches

Subtopics
9.5.1 Combining Search Words Using Boolean Operators

1 Copyright IBM Corp. 1989, 1994
95-1



BookManager Library Reader for Windows: User's Guid e
Combining Search Words Using Boolean Operators

9.5.1 Combining Search Words Using Boolean Operator S

Boolean operators let you specify a relationship between words or phrases in your search request so that you can make the search--and
therefore the results--more precise.

Note: The same Boolean search request may produce different results for an exact match search and a fuzzy match search. The
examples in this topic assume exact match searching.

Table 4 shows the three Boolean operators you can use in a search request:

G S +
| Table 4. Conditions for Using Boolean Operators i n Exact Match 1

1 Searches 1
G S 1

| Operator | Meaning | Conditions for using 1

+ + G 1

i & | AND | All words and phrases connected by & must be 1
1 i | present for the topic to be considered a search |
1 i { match. They do not have to be in the same 1

1 i | sentence, and they can be pr esent in the topic in |

1 i | any order, not necessarily t he same order as in |

1 i | the search request. 1

+ + G 1

1 i OR | Atleast one of the words or phrases connected by |
1 i 1 | must be present for the topic to be considered |

1 i | a search match. 1

+ + G 1

i ! | BUT NOT | The word or phrase to the le ft of the ! must be |
1 i | present in the topic, but th e word or phrase to |

1 i | the right must not be present, for the topicto |

1 i | be considered a search match . 1
G S 1

i Note: The total length of a search request, including a I words and |
1 symbols, cannot exceed 255 characters. 1
G S +

EXAMPLES
Jack & Jill matches any topic that contains both the word Jack and the word Jill.

Jack | Jill matches any topic that contains either the word Jack or the word Jill.
Jack ! Jill matches a topic only if that topic contains the word Jack without the word Jill.
If necessary, you can use parentheses--the (') symbols--to group words around Boolean operators so that BookManager Library Reader

for Windows interprets your search request as you intend. You can also use parentheses to change the order of precedence of Boolean
operators, meaning the order in which BookManager Library Reader for Windows processes Boolean operators in a search request.

EXAMPLES
Suppose you wanted to search for topics that contained the word Jack, the word Jill, and the phrase went up the hill. If you typed
Jack & Jill & went up the hill , a topic containing the sentence Jill got angry at Jack and went home. would be considered a

match, which is not what you intended. But if you typed Jack & Jill & (went up the hill)  then Library Reader for Windows would
know to look for went up the hill as a phrase and would find what you wanted.

Suppose you wanted to find any references to elephants or tigers or lions who happened to be in either a zoo or a circus. If you
typed elephants | tigers | lions & zoo | circus  without parentheses, then BookManager Library Reader for Windows would match
only topics containing both the words lions and zoo, because & takes precedence over |. But if you typed (elephants | tigers |
lions) & (zoo | circus) then Library Reader for Windows would find what you wanted.

Of course, you can also use wildcard characters in a search request that contains Boolean operators, and sometimes you may have to
use single quotation marks (") to search for a symbol in the text that BookManager Library Reader for Windows would otherwise interpret
as an operator. (For an explanation of when you need to use single quotation marks, see "Searching for Special Symbols" in topic 9.4.1.)
You can make your search request as complex as it needs to be, provided you stay within the 255-character limit.

EXAMPLES
To find all references to Erie, Panama, canals, locks, or inland waterways except for the C&O canal, you would type (Erie |
Panama | canal* | lock* | inland waterway*) ! C&O
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9.6 Changing Search Options

The settings of the search options tell BookManager Library Reader for Windows what type of search to perform, what parts of the book
to search, and how to show the results. There is also an option to always use the extended search dialog boxes (either or both) instead
of the basic search dialog boxes.

Search options mainly pertain to a book search; a cross-book search has no options other than which search dialog box to display when
you begin the search.

Subtopics

9.6.1 Specifying the Type of Search
9.6.2 Specifying Where to Search
9.6.3 Specifying How to Show Results

1 Copyright IBM Corp. 1989, 1994
96-1



BookManager Library Reader for Windows: User's Guid e
Specifying the Type of Search

9.6.1 Specifying the Type of Search

The options described in this topic tell BookManager Library Reader for Windows the type of search to perform during a book search.
You can change them temporarily in the Search Book (Extended) dialog box to affect the one search you are about to do, or you can
change them permanently in the Options - Search Book dialog box to affect all future book searches.

The search types are:

[1 Exact Match (with or without case-sensitivity)
[ Fuzzy Match

Exact Match
A exact match search finds exactly the words you type in your search request, in the order specified (the spaces you type
between words in the search request are not significant). An exact match search will also match capitalization if the
Case-Sensitive check box is also selected.

EXAMPLES
In an exact match search, the white house matches the white house, the white house, and the White House if
Case-Sensitive is not selected. It does not match house which is white.

Case-Sensitive
(This check box is only available when you have selected Exact Match .) If you want the search to find words whose capital
letters and small letters exactly match those in your search request, then select this check box. To have the search ignore
capitalization, treating upper case and lower case letters identically, clear this check box. Non-case-sensitive searches find all
occurrences of a word regardless of how it is capitalized, and therefore usually find more matches than case-sensitive
searches do.

EXAMPLES
When the Case-Sensitive check box is selected, ok matches ok.

When the Case-Sensitive check box is cleared, ok matches OK, Ok, ok, and oK.

Fuzzy Match
A fuzzy match search finds all occurrences of your search word in any form that shares the same language root: plurals, forms
with different endings, different verb forms including past or future tenses, and different capitalization or punctuation. If your
search request includes a phrase, then a fuzzy match search finds as matches those phrases that contain all the same
important words, even if they are not necessarily in the same order that you specified in your search phrase.

EXAMPLES
In a fuzzy match search, color matches color, colors, colored, coloring, colorful, and other forms of the word.

is matches is, am, are, and be.

go matches go, went, and gone, and Go. matches go. and go, as well as Gone! (ending your search word with a period
followed by a space finds the word with any kind of sentence-ending punctuation).

the white house matches the white house, white house, White House, and house which is white.
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9.6.2 Specifying Where to Search

The options described in this topic tell BookManager Library Reader for Windows what the focus of the search is--that is, what areas to
search during a book search. You can change the options temporarily in the Search Book (Extended) dialog box to affect the one search
you are about to do, or you can change them permanently in the Options - Search Book dialog box to affect all future book searches.

The areas you can search are:

[ Topic Titles
[ Topic Text
[ Indexed Words

The focus options for a book search can be selected in any combination, and at least one of them must be selected.

Topic Titles
Select this check box to have BookManager Library Reader for Windows search the text in topic titles. This check box can be
selected by itself, or in any combination with Topic Text and Indexed Words .

Topic Text

Select this check box to have BookManager Library Reader for Windows search the text of all the topics in the book. This check
box can be selected by itself, or in any combination with Topic Titles and Indexed Words .

Indexed Words
Select this check box to have BookManager Library Reader for Windows search the index entries of the book. This check box

can be selected by itself, or in any combination with Topic Titles and Indexed Words . This check box is not available when a
book does not have an index.

Index entries are not displayed in the Search Results navigator window. If an index entry is found as a search match, then a
message in the status bar of the Book window appears whenever the line of text that contains that index entry is visible in the
Book window and you have navigated to the matching index entry attached to that line, but can't see it.

Note: Words can be present as entries in a book's index even if they don't occur anywhere in topic text. This can happen when
authors put synonym words in the index that are not actually used within the book.

1 Copyright IBM Corp. 1989, 1994
9.6.2-1



BookManager Library Reader for Windows: User's Guid e
Specifying How to Show Results

9.6.3 Specifying How to Show Results

The options described in this topic tell BookManager Library Reader for Windows how to display the results of a book search. You can
change them temporarily in the Search Book (Extended) dialog box to affect the one search you are about to do, or you can change them
permanently in the Options - Search Book dialog box to affect all future book searches.

The options available for displaying the results of a book search are:

[J List Topics by Importance
[J List Topics in Sequence
[1 Go to Matches in Book Text

Either of the first two options opens a Search Results navigator window that lists the topics containing matches. From the Search Results
navigator, you can go to the search matches themselves in the topic text. The Search Results window lets you preview the topics
containing matches and decide which ones interest you most. The third option bypasses the Search Results window entirely and takes
you directly to the search matches in topic text in the Book window.

Regardless of which option you select, BookManager Library Reader for Windows emphasizes the search matches in the text of the book
by displaying them in a different color. While the book is open, you can turn this emphasis off and on by choosing the Emphasize
Matches command from the Search menu in the Book window. When you close the book, the emphasis disappears (and any related
Search Results windows close also).

Also regardless of which option you select, the Go to Next Match and Go to Previous Match icons or menu commands can take you
quickly from one match to another in the text of the book.

List Topics by Importance
Select this option button to have BookManager Library Reader for Windows present your search results as a list of the topics
that contain search matches. Library Reader for Windows lists the topics in a Search Results navigator window. The list is
ranked in order of probable importance; the topics most likely to be helpful are listed first. Library Reader for Windows selects
this option by default, unless you change it.

BookManager Library Reader for Windows determines the likely importance of a search match based on the following factors
listed in order of decreasing importance:

Location
Matches are likely to be of greater value if they occur in certain parts of the book.
[ In across-book search, matches found in book titles rank highest, followed by matches in the index, then in
headings, and then in the text.
[ In asingle-book search,
For example, matche s found in the index
rank highest, follo wed by matches in
headings, and then in the text.
Frequency

Topics with the most matches rank highest. When the request contains more than one search word or phrase,
frequency also depends on how many words or phrases match.

Exactness
Exact matches, including exact capitalization of letters, rank highest. Matches that differ only in capitalization rank next,
followed by matches that share the same root.

Distinctness
Matches for words or phrases that occur in only a few topics rank higher than matches that occur frequently
throughout the book. For example, if you search for the word cats and the phrase Siamese cats , matches for
Siamese cats rank higher than matches for cats. In this example, the added qualifier Siamese to cats makes the
phrase more distinct than the word.
Also, when two or more topics contain the same number of matches, shorter topics rank higher than longer topics.
Sequence similarity
Search matches on phrases are ranked according to their similarity to the search phrase. For example, matches on a
search for the forest cottage might rank as:
1. The forest cottage (identical sequence)
2. the enchanting forest cottage (identical sequence, with one insertion; contains three search-phrase words)

3. forest cottage (identical sequence, with one deletion; contains only two search-phrase words)

4. cottage in this forest (reverse sequence, with one deletion; contains only two search-phrase words)

List Topics in Sequence
Select this option button to have BookManager Library Reader for Windows present your search results as a list of the topics
that contain search matches. Library Reader for Windows lists the topics in a Search Results navigator window in the
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sequence in which they occur in the book, with no attempt to prioritize them by probable importance.

Go to Matches in Book Text
Select this option button to have BookManager Library Reader for Windows automatically scroll the topic text in the Book window
to the location of the first search match in the book, when matches are found. A Search Results navigator window is not used.
The search matches are emphasized in the topic text, unless the (check mark)Emphasize Matches command in the Search
menu has been turned off (if a checkmark appears to the left of the command, it is on). You can choose the Go to Next Match
and Go to Previous Match icons or commands to take you quickly from one match to another in the text of the book.
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9.7 Changing Search-Ranking Defaults

Your ability to change search-ranking defaults depends on whether you search a single book or multiple books. You have more flexibility
when searching a single book. You change search-ranking defaults by changing search options:

[ To temporarily change search options, choose Extended in either the Search Book window or the Search Multiple Books window.

[J To permanently change search options, update your user profile by choosing Searches from the Options menu. A Searches
cascading menu appears, from which you:

- Choose Book to permanently change book search options.
- Choose Bookshelf to permanently change cross-book search options.

Subtopics
9.7.1 Changing Defaults for a Multiple-Book Search
9.7.2 Changing Defaults for a Book Search
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9.7.1 Changing Defaults for a Multiple-Book Search

In a cross-book search, the only search-ranking default you can change is the operators' order of precedence. Adding grouping
operators to a Boolean expression overrides the Boolean operators' default order of precedence. When searching multible books:

[1 Fuzzy Match is the only Type of Search used in cross-book searches; you cannot request Exact Match .

[1 BookManager Library Reader for Windows always searches Topic Titles , Topic Text , and Indexed Words in cross-book searches;
you cannot focus your search by selecting some combination.

Note: You can locate words or phrases in book titles by selecting Include by Title from the View menu.
[1 BookManager Library Reader for Windows always shows cross-book search results by importance; you cannot request that they be

listed in sequence. Nor can you request to be taken directly to search matches; cross-book search results are always displayed in a
navigator.
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9.7.2 Changing Defaults for a Book Search
You have a lot more control over search results ranking when you search a single book. For example:
[ You can add grouping operators to a Boolean search request to override the Boolean operators' default order of precedence.

[ You can choose Exact Match instead of Fuzzy Match to eliminate the need for some ranking:

- Exactness no longer applies if you want capitalization honored.
- Sequence similarity no longer applies.

[ Requesting that results be listed in sequence instead of by importance eliminates the need for all ranking; location, frequency,
exactness, distinctness, and sequence similarity no longer apply. For this reason, selecting List Topics in Sequence can improve the
speed with which BookManager Library Reader for Windows processes your search request.

Note: The algorithm used by BookManager Library Reader for Windows to rank search results contains an enhancement over the
algorithm used by previous BookManager READ products and, therefore, may yield slightly different--but more accurate--results.
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9.8 Viewing Search Results
BookManager Library Reader for Windows displays search results differently for a book search and a cross-book search.

Matches from a book search are givensearch emphasis in the topic text in a different color, if Emphasize Matches is checkmarked. In
addition, Library Reader for Windows optionally lists the topics containing the search matches in a Search Results navigator window. You
can control whether BookManager Library Reader for Windows uses the Search Results navigator window by using the List Topics by
Importance or List Topics in Sequence option buttons in the Search Book (Extended) or Options - Search Book dialog boxes. For
detailed information about that, see "Specifying How to Show Results" in topic 9.6.3.

BookManager Library Reader for Windows displays the results of a cross-book search in stages. First it displays a list of books
containing matches in a Multiple-Book Search Results dialog box. Then, choosing one of the listed books automatically repeats the same
search within that book to pinpoint the topics containing the matches, and opens a Book window showing the matches emphasized. If
either the List Topics by Importance  or List Topics in Sequence search option is in effect, then a Search Results navigator is also
opened.

There is another way to work with the results of a cross-book search: from the Bookshelf window or List of Books window where you
originally did the search. Using the Select Only Books with Search Matches = command from the Edit menu in either of those windows,
you can list just those books that contain search matches, making it convenient for you to work with the books containing matches as a
group. For example, you might want to add them to a new bookshelf created specifically for them.
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10.0 Using the Bookmark
To help you keep your place when you're interrupted, or to mark some information you'll need for frequent reference, BookManager Library
Reader for Windows provides each book with an electronic bookmark.

There is one bookmark for each book. You can place the bookmark at any point in the book. The bookmark remains in place until you
remove it.

This chapter explains how to place, find, and remove the bookmark.

Subtopics
10.1 Placing, Finding, and Removing the Bookmark
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10.1 Placing, Finding, and Removing the Bookmark

To place the bookmark in a softcopy book:

1. In the Book window, display the topic in which you want to place the bookmark.

2. Choose Edit/Place Bookmark .

The Bookmark icon

the topic. If you are

appears in the left margin of the first line of
not already at the top of the topic, you must s croll backward to see
the Bookmark icon.

To move the bookmark, just place it again at a new location.

To find the bookmark:

[J In the Book window, choose Navigate/Go to Bookmark .

The book displays text at bookmark's location.
You can also find the bookmark by just opening the book. The book automatically opens to the beginning of the topic containing the

bookmark you've placed.

To remove the bookmark:

[ In the Book window, choose Edit/Remove Bookmark .

A message appears in the status bar confirming that the bookmark has been removed.
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11.0 Making Notes in a Book
A Library Reader for Windows note is similar to a note you might write in the margin of a printed book, except that you type the note online,
and when you're finished you see a note icon in the left margin of the book. You click the note icon to view text of the note itself.

This chapter describes how to make electronic notes in a BookManager Library Reader for Windows softcopy book.

Subtopics

11.1 Creating a Note

11.2 Viewing Notes

11.3 Changing a Note

11.4 Deleting a Note

11.5 Accessing Other People's Notes
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11.1 Creating a Note

You can attach electronic notes to topic text and to integrated pictures. The note icon flags the specific line or picture to which your note is
attached. You can put more than one note in the same spot. A line or picture with only one note has this icon next to it:

and one containing multiple notes has this icon:

e

To create a note:

1. In the Book window, put the insertion point anywhere in the line or picture for which you want to create the note.

2. From the tool bar, choose

or from the Notes menu, choose New.
The Note dialog box appears.
3. Type the text of your note, or copy information from the Clipboard.
To move the insertion point to a new line, press Enter or just keep typing.
4. To save the note, choose Save.
The Note dialog box closes and the note icon appears in the left margin.
BookManager Library Reader for Windows saves the note in a notes file that has the same file name as the book, but a file extension of
.NTF, for example, THISBOOK.NTF.

The Note dialog box is resizeable, and the note text reflows to fit. Also, unlike most other dialog boxes, you can work with other windows
while you are using the Note dialog box. This means that you can move through the book or even work with other books while you are
composing your note.
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11.2 Viewing Notes
You can open, change, and delete notes to which you have read/write access.

Subtopics
11.2.1 Opening a Note
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11.2.1 Opening a Note

To open a note from the note icon:

1. In the Book window, scroll to the line or picture that has a note icon.
2. Double-click the note icon using mouse button 1.

The Note dialog box appears. If the line of text has only one note, the entire note text appears in the dialog box.

If the line of text has several notes, the text of the first note appears,
regardless of what sequence the notes were created in.
To open any other notes on the line of text orin t he notes file:

[ In the Note dialog box, choose Next or Previous .

These buttons are dimmed if no other notes exist for the book.

TIP: You'll know if your note is in a different topic because the topic title above the note text in the Note dialog box changes.

To open a note using the Notes List navigator:

1. In the Book window, choose Notes/Display Notes List , or choose

The Notes List navigator appears, listing all the notes in the book.
2. In the notes list, double-click the line you want to view.

The Notes List navigator closes and a Note dialog box opens, displaying the note.
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11.3 Changing a Note

You can change any note that you have created. However, if you are reading someone else's notes, you can change only those to which
you have read/write access.

To change a note:

1. Open the note from its note icon or from the Notes List navigator.
The Note dialog box appears with the text of the note in it.

2. Type your changes to the note text.

3. Choose Save to save your changes to the note.

BookManager Library Reader for Windows saves the note and closes the Note dialog box. The icon for the note remains in the same
place.

If you can only view a note and not change it, the Save, Delete , Cut, and
Paste command buttons on the Note dialog box are dimmed.
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11.4 Deleting a Note
You can delete any note that you have created. If the notes file is located on your computer, then you can delete any note in it, even if
someone else created it.

If the notes file is located on a LAN, you can delete notes only if you have read/write access to the file.
Although you are not required to open a note to delete it, deleting a note whose text you can see is safest.

To delete a note by viewing its text first:

1. Open the note by double-clicking its icon.
2. In the Note dialog box, read the note text, and then choose Delete.
3. When the confirmation message appears, choose OK.

To delete a note without viewing its text:

1. In the Book window, choose Notes/Display Notes List

The Notes List navigator appears.
2. In the Notes List navigator, select the note you want to delete.
3. From the Notes menu in the Notes List navigator, choose Delete .
4. When the confirmation message appears, choose OK.
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11.5 Accessing Other People's Notes

You might want to read notes that other people have made for the same book, which they are reading from either their own computers or
from a LAN.

BookManager Library Reader for Windows stores notes in file that is separate from the softcopy book to which they pertain. Other
readers' notes file for the book will have the same file name as your notes file. They can give you their notes files on diskette, or put their
notes file in a LAN directory to which you also have access.

Subtopics

11.5.1 Rename Their Notes File!

11.5.2 Opening Other People's Note Files
11.5.3 Are My Notes Public or Private?
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11.5.1 Rename Their Notes File!

If they give you a notes file that has the same name as yours, and you want to put their file on your computer, then you must rename their
file or yours to avoid accidentally erasing either one. Use Windows File Manager or DOS commands to rename a file.

The default notes file typically has the same file name as the book, but with a file extension of .NTF. For example, if the book file is named
THISBOOK.BOO, then the notes file is named THISBOOK.NTF.

A notes file can have any file name and any file extension, however.
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11.5.2 Opening Other People's Note Files

To open a note files located in another directory f or the same book:

[ In the Book window, choose Notes/Use Other Notes .

An Open dialog box similar to a typical Windows Open dialog box appears, from which you can select the drive, directory, and file that
you want. The default selections are the current drive and path.

When you open a notes file from the Open dialog box, BookManager Library Reader for Windows gets the notes and displays note icons
for them at the appropriate lines of topic text. It exchanges them for the set of notes you had been using. The old notes are no longer
visible, but they are not deleted; to get them back, open the notes file that contains them.
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11.5.3 Are My Notes Public or Private?

Your notes are private as long as your notes file is stored on your computer. To make them public, you must either give your notes file to
someone on diskette, or put your notes file on a LAN directory to which others have access. You specify where your note file is stored in
a notes file path in the Options - Startup Defaults dialog box.
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12.0 Printing and Copying
You can use BookManager Library Reader for Windows in various ways to print information from a softcopy book.

BookManager Library Reader for Windows gives you the ability to print:

The entire book

One or more selected topics

Specific topic text

Only the topics containing search matches

Only the topics containing notes, with or without the note text included
Notes alone

Topics containing revisions

Topics that you have already seen

Pictures (6) in the book

ODooooooog

The printer can be physically connected to your PC or available to you from a LAN.
(6) Some considerations about printing pictures:
- You must have a graphics printer to print pictures. contains an integrated picture,

- Pictures are bitmaps; their printed quality depends on the dots-per-inch (DPI) resolution of your printer. A picture that comes out
cropped at the right and bottom margins when printed on a matrix printer might show up whole on a page printed on a laser printer.

Subtopics

12.1 Printing an Entire Book

12.2 Printing Marked Text

12.3 Printing One Topic

12.4 Printing Selected Topics from Navigator Windows
12.5 Printing Notes

12.6 Printing Pictures

12.7 Previewing Your Printed Output

12.8 Copying (Printing) to a File

12.9 Copying to the Clipboard

1 Copyright IBM Corp. 1989, 1994
12.0-1



BookManager Library Reader for Windows: User's Guid e
Printing an Entire Book

12.1 Printing an Entire Book

You can print an entire book from the Book window or from the command line. When you print from the Book window, you can also
include the text of any notes that pertain to the book.

To print an open book from a Book window:

1. From the tool bar, choose

or from the File menu, choose Print
The Print dialog box appears.

2. (Optional) To print on a printer other than the one displayed in the Printer text box, or to change your printer settings, choose Setup .
A standard Windows Print Setup dialog box appears. If you change your printer settings, choose OK.

3. In the Print dialog box, from the What to Print group, select Entire Book .

4. From the What to Include group, select Topics Only , to print all topics without notes included, or Topics and Notes to include notes
as well.

5. Choose OK.
A print progress message is displayed while the book is transferred to Microsoft Windows Print Manager. To discontinue printing, choose
Cancel at any time.
To print a book from the command line:
1. From the File menu in Program Manager or File Manager, choose Run.
2. In the Command Line text box in the Run dialog box, type:
[ readibm bookname /p
where bookname is the file name of the book you want to print.

EXAMPLE
To print the BookManager Library Reader for Windows User's Guide you type:

readibm ejrl2m00 /p

3. Choose OK.

Library Reader for Windows displays the book in a Book window and begins printing the book automatically.

1 Copyright IBM Corp. 1989, 1994
121-1



BookManager Library Reader for Windows: User's Guid e
Printing Marked Text

12.2 Printing Marked Text
Printing marked topic text--which can include integrated pictures--is very similar to printing an entire book.

To print marked text in a topic:

1. Mark the block of text or integrated picture that you want to print.

If the text you mark contains an integrated picture, the entire picture prints. If the text contains a picture link, for example, PICTURE 1,
then the words PICTURE 1 print instead.

2. From the tool bar, choose

or from the File menu, choose Print
3. Inthe What to Print group, select Marked Text .

4. Choose OK
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12.3 Printing One Topic

To print a single topic from the Book window:

1. In the Book window, go to the topic you want to print.

2. From the tool bar, choose

==

or from the File menu, choose Print
3. Inthe What to Print group, select Current Topic .
4. In the What to Include group, select whether or not to print notes with the topic.

5. Choose OK.
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12.4 Printing Selected Topics from Navigator Window S
Through navigator windows, you can print topics that:

You've selected

Contain search matches

Contain notes (with or without the note text included)
Contain revisions

You've already seen

OOooo-g

To print one or more topics from a navigator window

1. Open the navigator window that you want.

+ +
i To print topics that... i Open this navigator... H
+ + :
i You select | Topics 1

+ + :
| Contain search matches | Search Re sults |

+ + :
i Contain notes | Notes Lis t 1

+ + :
i Contain revisions | Revisions 1

+ + :
i You have already seen | Topics-Se en '

+ +

2. In the navigator window, select the topic or topics that you want to print. You can select topic titles that are not next to each other.
To select all the topics listed, choose Edit/Select All in the navigator window.

3. From the Print menu in the navigator window, choose Print Selected Topics .
The Print Selected Topics dialog box appears.

4. In the What to Include group, select whether or not to print notes.

5. Choose OK.

Subtopics
12.4.1 Make Sure You Can See Those Subtopics
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12.4.1 Make Sure You Can See Those Subtopics

When you print from the Topics navigator, be sure that any hidden subtopics you want to print are visible and selected.
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12.5 Printing Notes

To print only those topics that contain notes, alon g with the text of the
notes themselves:

1. From the tool bar, choose

or from the File menu, choose Print
2. In the What to Print group, select Current Topic .

3. Inthe What to Include group, select Only Topics with Notes

To print only notes by themselves, without the text of the topics they
pertain to:

1. From the tool bar, choose

or from the File menu, choose Print
2. In the What to Print group, select Current Topic .

3. Inthe What to Include group, select Notes Only .
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12.6 Printing Pictures
You must have a graphics printer to print pictures.

To print a picture displayed in a Picture window:

[ From the Picture window in which the picture is displayed, choose Print/Print Picture .

To print a picture that is integrated in text:

1. In the topic text, mark the integrated picture.
2. Choose

from the tool bar to print it as marked text.

Remember that if you mark a picture link, such as PICTURE 1, the words "PICTURE 1" will print.
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12.7 Previewing Your Printed Output

Before you print a topic, you can preview the formatted output online. This gives you a chance to refine the format by adjusting the printer
options before you actually send the output to a printer.

You can preview the topic with or without displaying it in the Book window.

To preview a topic that is displayed in the Book wi ndow:

1. In the Book window, display the topic you intend to print. Make sure that the topic-text side of the Book window is active.

2. From the File menu, choose Print Preview .

3. A standard Microsoft Windows Print Preview dialog box appears, displaying what your formatted output will look like when printed.
You can zoom in on a particular area, or view two pages side by side. For detailed information about using this dialog box, refer to the

Microsoft Windows User's Guide.

To preview a topic without displaying it in the Boo k window:

1. In a navigator window, select the title of the topic you intend to print. (7)
2. From the Print menu, choose Print Preview .
3. The Microsoft Windows Print Preview dialog box appears, displaying what your formatted output will look like when printed.

(7) Although it is possible to select more than one topic title in the navigator dialog box, only the first selected title in the list will be
previewed.
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12.8 Copying (Printing) to a File
Copying information from a softcopy book into an ASCII disk file is also known as "printing to a file."
Note: Pictures that are integrated in topic text are not included in the text that is copied to a file.

To copy information from a softcopy book into a fil e:

1. From the tool bar, choose

or from the File menu, choose Print
2. Make your selections from the What to Print group and What to Include group.
3. Select the check box labeled Print to File and choose OK.
The dialog box called Print to File from appears, which is similar to a typical Microsoft Windows Save As dialog box.

4. Verify that the default file name, drive, and directory are what you want. If you type the name of a file that already exists, BookManager
Library Reader for Windows asks you to confirm that you want to replace it.

5. Choose OK.

Library Reader for Windows copies the book text into the file as plain ASCII text, without printing the text, and without copying any
pictures that are integrated in the text.

6. When the completion message appears, choose OK.
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12.9 Copying to the Clipboard

You can copy topic text, notes, and pictures from a softcopy book to the Clipboard using standard Microsoft Windows copy techniques,
for example, choosing Edit/Copy . Before you copy information from a copyrighted book, make sure you understand any legal restrictions
or implications.

Any information that you copy to the Clipboard, whether from BookManager Library Reader for Windows or some other application, can be
pasted into a new or existing note.
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13.0 Creating and Maintaining Bookcases and Bookshe Ilves
This chapter describes how to create a Library Reader for Windows bookshelf, add books to it, and remove books from it.

You can create an empty bookshelf or a bookshelf that contains books you have selected.

Once you have a bookshelf, you can maintain it by adding other books to it and removing books from it. You can also add books to a
bookshelf you are not currently using.

Subtopics

13.1 Creating Bookcases

13.2 Maintaining Your Bookcases
13.3 Creating Bookshelves

13.4 Maintaining your Bookshelves
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13.1 Creating Bookcases

You create bookcases from the List of Bookcases window or the Bookcase window. The bookcase you create is empty. After you create
it you can add bookshelves and nested bookcases to it.

To create a bookcase:
1. From the List of Bookcases or Bookcase window, choose File / Create Bookcase
The Create a Bookcase dialog box appears, which you use in much the same way you use a Windows Save As dialog box.

2. In the File Name field, type a name for your bookcase. The name must conform to DOS conventions for naming files, with an
extention of .BKC.

3. Choose OK
The Create Bookcase information dialog box appears
4. Type the path in which your new bookcase will reside.
5. Type your bookcase title
The title can be as long as 255 characters, but the longer the title, the further you'll have to scroll to see it.

6. Choose OK.

If your List of Bookcase is open, choose View / Refresh to display the new bookcase in the list.
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13.2 Maintaining Your Bookcases
You maintain your bookcases by adding and removing items from them.
To add to your bookcase:

1. From the Bookcase window, choose File / Modify Bookcase or, in the List of Bookcases window, select the nested bookcase you
want to modify and choose File / Modify Selected Bookcase

2. In the Modify Bookcase dialog box that appears, type the paths in which your bookcases and bookshelves reside in the Select Paths
to Add Bookcase or Bookshelves From  field. Separate the paths with semicolons (;).

3. To add bookcases, choose the Add Bookcases button.
4. In the dialog box that appears, select the bookcases you want to add and choose OK
5. To add bookshelves, choose the Add Bookshelves button.

6. In the dialog box that appears, select the bookshelves you want to add and choose OK

To remove bookshelves or nested bookcases:

1. From the Bookcase window, choose File / Modify Bookcase or, in the List of Bookcases window, select the nested bookcase you
want to modify and choose File / Modify Selected Bookcase

The Modify Bookcase dialog box appears.
2. In the Select Bookcases and Bookshelves to Remove field, select what you want to remove.

3. Choose OK
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13.3 Creating Bookshelves
You create bookshelves from any of these windows:

[ List of Bookshelves
[ List of Books
[1 Bookshelf

Subtopics

13.3.1 Find Out If You Have a Search Index

13.3.2 Give Your Bookshelf a Name

13.3.3 Creating an Empty Bookshelf

13.3.4 Creating a Bookshelf Containing Books You Select
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13.3.1 Find Out If You Have a Search Index

Before creating a bookshelf, find out whether the books' authors listed the books in a bookshelf search index. If so, have the name of the
search index file at hand when you're ready to create the bookshelf.
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13.3.2 Give Your Bookshelf a Name

You can give your bookshelf a name that is different from its file name. A bookshelf name appears under the Name column in the List of
Bookshelves, and in the title bar of the Bookshelf window. If you don't specify something different, the bookshelf name will be the same as

the file name.
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13.3.3 Creating an Empty Bookshelf

To create an empty bookshelf:

1. From the List of Bookshelves window, List of Books window, or Bookshelf window, choose File/Create Bookshelf .

The Create Bookshelf dialog box appears, which you use in much the same way you use a Windows Save As dialog box.

2. In the File Name text box, type a file name for your bookshelf.

The file name must conform to DOS conventions for naming files, with a file extension of .BKS. If you omit the .BKS file extension, is
supplied automatically.

Use any existing bookshelves listed in the current directory as a guide for typing your new bookshelf file name.

3. Choose OK.

If you are replacing an existing bookshelf, choose Yes when the confirmation message appears.

The Create Bookshelf Information dialog box appears:

= Create Bookshelf Information

Bookzhelf Title:

Bookzhelf Mame: MYSHELF

Search Index:

1] 4 l | Cancel I | Help I

Figure 7. Create Bookshelf Information Dialog Box

4. Type your bookshelf title.

The title can be as long as 255 characters, but keep in mind that you'll have to scroll if it is very long.
(If you don't want to change the bookshelf name, and if your bookshelf doesn't have a search index, choose OK.)

. The Bookshelf Name text box is prefilled with the bookshelf's file name. Type your new name over it if you want the bookshelf name to
be different than its file name. You must specify a hame; the text box can't be blank.

The bookshelf name must not exceed 8 characters, but there are no other restrictions on the characters you can type as part of the
name. It can even have imbedded spaces, although each space counts toward the 8-character limit.

. (Optional) Type the file name of the bookshelf search index, if one exists. Do not type a file extention or or a path; the bookshelf
search index file must have an extension of .BKI and be located either in a directory named in your startup path or else in the same
directory as the bookshelf file.

. Choose OK.

. When a message appears, indicating the bookshelf is successfully created, choose OK.

. If your List of Bookshelves window is open, choose View/Refresh .

Your new, empty bookshelf appears in the List of Bookshelves after the window has been refreshed.
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13.3.4 Creating a Bookshelf Containing Books You Se lect
To create a bookshelf and add books to it at the same time:

1. In either the Bookshelf window or List of Books window, select the book or books you want.
You can select books from one window or the other, but not both at the same time.

2. Choose File/Create Bookshelf .
The Create Bookshelf dialog box appears.

3. In the Create Bookshelf dialog box, type the bookshelf file name, then choose OK.
The Create Bookshelf Information dialog box appears.

4. In the Create Bookshelf Information dialog box, type the bookshelf title. Optionally change the bookshelf name, and type the search
index file name if there is one.

Choose OK.
5. When the message appears, indicating that the bookshelf is successfully created, choose OK.
6. When the "Add the selected books to this bookshelf?" message appears, choose Yes.

The books you previously selected are added to the new bookshelf. BookManager Library Reader for Windows does not open the new
bookshelf automatically.

7. If the List of Bookshelves window is open, choose View/Refresh .

After the window has been refreshed, your new bookshelf appears in the List of Bookshelves.
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13.4 Maintaining your Bookshelves

You maintain your bookshelves by adding books to them, and removing books from them, keeping the shelves up to date.

Subtopics

13.4.1 Adding Books to a Bookshelf
13.4.2 Removing Books from a Bookshelf
13.4.3 Keeping Bookshelves Up-to-Date
13.4.4 Deleting a Bookshelf
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13.4.1 Adding Books to a Bookshelf

You can add books to a bookshelf that you are currently using, or to a bookshelf that you are not currently using. To add books to a
bookshelf you are currently using:

1. In the Bookshelf window, choose File/Add Other Books to This Bookshelf

The Add Other Books to This Bookshelf dialog box appears:

Add Other Books to This Bookshelf

Available Books-

EJRwW2MO0 BookManager READ For Windows:
EJRW3MO0 BookManager READ for Windows
EJRWEBMOD BookManager READ for Windows:
EJRWEBMO1 BookManager READ for Windows:

| +

Add | | Find.. | | Cancel | | Help

Figure 8. Add Other Books to This Bookshelf Dialog Box
2. Select the books you want from the list.

The Add Other Books to This Bookshelf dialog box lists books found in your startup path. If you want to list books from other directories,
choose Find and select books from the List of Books.

3. Choose Add.

The Add Other Books to This Bookshelf dialog box closes, and the new books appear in the Bookshelf window.

To add books to a shelf you are not currently using
1. In either the Bookshelf window or List of Books window, select the book or books you want.
2. From the File menu, choose Add Selected Books to Another Bookshelf

The Add Selected Books to Another Bookshelf dialog box appears:
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= Add Selected Books to Another Bookshelf

Available Bookshelves:

EJABSMOOD  READ for Windows Documentation =~~~

|§leate...| |Eanc:el| | Help I

Figure 9. Add Selected Books to Another Bookshelf D ialog Box
3. In the Available Bookshelves list box, select the bookshelf to which you want to add the selected books.

If the bookshelf you want does not appear in the list, either choose Find and select from the List of Bookshelves, or choose Create to
create a new bookshelf.

4. When you've selected the bookshelf you want to add books to, choose Add .
The Add Selected Books to Another Bookshelf dialog box closes.
5. When a message appears, indicating that the books have been added, choose OK.
6. (Optional) If the bookshelf to which you just added books is open, from its View menu choose Refresh .

After the window has been refreshed, the newly added books appear in the list.
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13.4.2 Removing Books from a Bookshelf

A bookshelf does not physically contain the softcopy books added to it; it only lists their names and some descriptive information about
each. So when you a remove a book from a bookshelf, you are only erasing its name from the list, not deleting the its file from storage. To

remove one or more books from a bookshelf:

1. In the Bookshelf window, select the book or books you want to remove.
2. Choose File/Remove Selected Books from This Bookshelf

3. When the confirmation message appears, choose OK.

BookManager Library Reader for Windows refreshes the Bookshelf window, and the books you removed disappear from the list.
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13.4.3 Keeping Bookshelves Up-to-Date

The book's descriptive information, such as book title or date built can become obsolete in the bookshelf if the book file is rebuilt after the
bookshelf is created. When descriptive information becomes obsolete, BookManager Library Reader for Windows displays a message in
the status bar of the Bookshelf window when you open the book from the bookshelf. To update the book's information in the bookshelf,
you must remove the book from the bookshelf, then add it again.
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13.4.4 Deleting a Bookshelf

To delete the bookshelf itself, you must use Microsoft Windows File Manager or DOS commands to delete the files of any bookshelves
you no longer want. Remember that deleting a bookshelf file does not delete the book files that belong to that bookshelf.
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14.0 Exiting BookManager Library Reader for Windows
You end the BookManager Library Reader for Windows session by closing the List of Bookshelves window or List of Bookcases. When
you close the List of Bookshelves or List of Bookcases, all windows that were opened directly or indirectly from it are also closed.

To close the List of Bookshelves or List of Bookcas es window and exit
BookManager Library Reader for Windows:

1. In the List of Bookshelves or List of Bookcases window, choose File/Exit .
2. If you've set a confirmation message to appear, choose OK when it does.

All BookManager Library Reader for Windows windows close, and the application ends.
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GLOSSARY Glossary of Terms and Abbreviations
This glossary defines all new terms and abbreviations used in this document. If you do not find the term you are looking for here, refer to
the index of this document or to the IBM Dictionary of Computing, SC20-1699. Any terms in this book that were derived from the following
sources are identified by the symbols indicated:

[ The American National Standard Dictionary for Information Systems, ANSI X3.172-1990, copyright 1990 by the American National
Standards Institute (ANSI). Copies can be purchased from the American National Standards Institute, 1430 Broadway, New York, New
York 10018. Definitions are identified by the symbol (A) after the definition.

[1 The Information Technology Vocabulary, developed by Subcommittee 1, Joint Technical Committee 1, of the International Organization
for Standardization and the International Electrotechnical Commission (ISO/IEC JTC1/SC1). Definitions of published parts of this
vocabulary are identified by the symbol (1) after the definition; definitions taken from draft international standards, committee drafts, and
working papers being developed by ISO/IEC JTC1/SC1 are identified by the symbol (T) after the definition, indicating that final agreement
has not yet been reached among the participating National Bodies of SC1.

[l The Microsoft Windows User's Guide, copyright 1990-1992 by the Microsoft Corporation. Definitions taken from the User's Guide
glossary are identified by the symbol (W) after the definition.

access . To obtain the use of a computer resource. (T)

action . A defined task that BookManager Library Reader for Windows performs. You initiate an action by doing any of the following:

Choosing a menu command
Choosing a command button
Pressing a function key
Pressing a shortcut key
Typing a command

OOooo-g

activate . (1) To make a window, bookshelf, book, topic, tool bar, or status bar visible and ready for use. (2) To cause changes that you
have made to options to take effect.

active . The window or icon that you are currently using or that is currently selected. Only one window or icon can be active at a time.
Keystrokes and commands affect the active window or icon. If a window is active, its title bar changes color to differentiate it from other
windows. If anicon is active, its label changes color. Windows or icons on the desktop that are not selected are inactive. (W)

active window . The window that can receive input from the keyboard, which is the window with which you are currently interacting, or the
last window that was activated. The active window is indicated by a title bar and border in a different color or shade from all other
windows. Contrast with inactive window.

Advanced Function Printing (AFP) . A set of licensed programs or user applications that permits all-points-addressable printing of text
and graphics on a page printer.

American National Standard Code for Information Int ~ erchange (ASCII) . The standard code, using a coded character set consisting
of 7-bit coded characters (8 bits including parity check), that is used for information interchange among data processing systems, data
communication systems, and associated equipment. The ASCII set consists of control characters and graphic characters. (A)

application . (1) A collection of software components used to perform specific types of work on a computer. (2) A program written for or
by a user that applies to the user's work, such as a program that does inventory control or payroll.

application programming interface (API) . (1) A functional interface supplied by the operating system or by a separately orderable
licensed program that allows an application program written in a high-level language to use specific data or functions of the operating
system or the licensed program. (2) The interface through which an application program interacts with an access method.

ASCIl. See American National Standard Code for Information Interchange (ASCII).

author . The person who wrote or prepared the information in a BookManager softcopy document.

autozoom . A picture function that lets you automatically enlarge (zoom in on) a portion of a picture that you have selected using the
mouse. When the autozoom function is on, you can select the picture portion and zoom in on it in one step. See also zoom in.

available choice . A menu command that you are able to use. Available choices are not dimmed. Contrast with unavailable choice. See
also dimmed.
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back matter . Topics that are placed after the main chapters or topics in a book. Back matter often includes a glossary, a bibliography,
and an index.

book . In BookManager, a softcopy document, created by BookManager BUILD, that can be read and searched at a display device using
BookManager READ. A softcopy book often has the traditional structure of a printed book, including standard book elements such as a
cover page, table of contents, chapters, and an index.

Book Description window . A window that provides information about a book, such as the book's title, author, publication date, and
document number.

book file name . Synonym for book name.

book metaphor . A conceptual model for presenting softcopy information. The book metaphor helps BookManager softcopy to simulate
the look and feel of a printed book.

book name . The file name of a softcopy book.

book search . A search done within a single book, on selected topics or on the entire book. Results of a book search are optionally
displayed in a Search Results window. Search matches are emphasized in the book text. Contrast with multiple-book search.

book session . The period of time during which a book is displayed in a Book window. When more than one book is open at the same
time, there is a separate ongoing book session for each. See also BookManager Library Reader for Windows session.

book text . The information contained in a softcopy book that is displayed in the left side of a Book window.

Book window . The window in which the text of a softcopy book is displayed.

bookcase . In BookManager, a logical grouping of bookshelves and/or other bookcases that allows them to be organized for convenience
and for faster searching.

BookManager Library Reader for Windows session . (1) The period of time between starting BookManager Library Reader for
Windows and exiting it. (2) The period of time during which the List of Bookshelves window is open.

bookmark . In BookManager, a placeholder that you can add to a softcopy book. For each open book, there is one bookmark that you
can place, find, or remove at any time.

bookshelf . In BookManager, a logical grouping of softcopy books that allows them to be organized for convenience and for faster
searching.

bookshelf file name . A name for a file with an extension of .BKS, which contains the definition of a bookshelf. The file name must
conform to DOS conventions for naming files and does not have to be the same as the bookshelf name. Contrast with bookshelf name
and bookshelf title.

bookshelf name . The BookManager name assigned by the creator of a bookshelf for the bookshelf. It can be viewed in the Bookshelf
Description dialog box. Contrast with bookshelf file name and bookshelf title.

bookshelf search index . Synonym for search index.

bookshelf title . The title assigned by the creator of a bookshelf for the bookshelf. It can be viewed in the Bookshelf Description dialog
box or List of Bookshelves window. It can be up to 255 characters in length. Contrast with bookshelf file name, and bookshelf name.

Bookshelf window . A window that lists all the books on a bookshelf.

Boolean . A process where combinatorial relationships are established between elements and the result takes on one of two values. In a
Boolean operation, each of the elements may be assigned a value, such as 0 or 1, true or false. The elements may then be combined in
Boolean expressions, using Boolean operators to establish the relationship between the elements. This evaluation can take place in a
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truth table, which shows the logical outcome of evaluating the expression for all possible cases. See also Boolean search.

Boolean operators . The &, |, and! characters that can be used to join two search words together such that both words, one or the
other, or one but not the other, are found in the text to satisfy the search request.

Boolean search . A search method that uses Boolean processing to analyze search matches. Boolean operators are used in a search
request to make a Boolean expression.

build a book . To use BookManager BUILD to create a softcopy book from source files.

+o-t
1 1
1 C 1
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cancel . To remove the current window or menu without processing it, and return to the previously active window.
cascading menu command . A command on a menu that produces a cascading menu containing more commands. A cascading menu

command is indicated by a right arrowhead next to it.

case. The characteristic of a letter that determines whether it is a capital letter or a small letter. Case is generally referred to as
uppercase, lowercase, and mixed case.

CD-ROM. See compact disc-read only memory (CD-ROM).

chapter . In BookManager, a section or part of a softcopy book whose topic ID begins with a major topic number, such as 1.0 or 4.0. See
also topic identifier

character . Any letter, number, ideogram, or other symbol used for the organization, control, or representation of data.

check mark . A symbol used next to a menu command to indicate that the command is in effect. For example, when a check mark

appears next to the Tool Bar menu command, it indicates that the tool bar is visible.

choose . To use a mouse or keyboard to pick an item that begins an action in Windows. You choose commands on menus to perform
tasks, and you choose icons to start applications. (W) Contrast with select.

clear. To turn off an option by removing the X from a check box. You clear a check box by clicking it, or selecting it and pressing the
Spacebar. (W) Contrast with select.

click . To press and release a mouse button quickly. (W) Contrast with double-click.

Clipboard . A temporary storage location used to transfer data between documents and applications. Typically, you transfer data to the
Clipboard by using an application's Copy or Cut command, and you insert data from the Clipboard by using the application's Paste
command. You can use the Windows Clipboard Viewer to view the contents of the Clipboard. (W)

close . Toremove a window or dialog box, or quit an application. You can close a window by using the Close command on the Control
menu. When you close an application window, you quit the application. (W)

collapse . To click on the icon (-) next to a topic title, thereby causing the titles of all its subtopics to be hidden from view. See also
subtopic and click.

command prompt . Synonym for DOS prompt

compact disc-read only memory (CD-ROM) . High-capacity, read-only memory in the form of an optically read compact disc.

confirmation message . A message that appears after you specify certain actions, prompting you to confirm that you want to continue
with the action or to specify that you want to cancel it. (W)

copy . (1) To put a copy of the selected text or item onto the Clipboard so that you can transfer it to another location. Most Windows
applications have a Copy command on the Edit menu that performs this task. (W)

cross-book link . A link that takes you from one softcopy book to another softcopy book in the same bookshelf or List of Books. Contrast
with intra-document link. See also hypertext link.
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cross-reference link . Emphasized text you can select to display the topic, figure, table, or text being referenced. See also cross-book
link and hypertext link.

current directory . The directory that you are currently working in. (W)

current topic . The topic that is displayed in the left side of the Book window.

cursor . Synonym for insertion point and selection cursor.

cursor movement keys . The Left Arrow, Right Arrow, Up Arrow, and Down Arrow keys on the keyboard that move the cursor in the
directions that the arrows point. Also known as arrow keys.

+o-t
1 1
1 D 1
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default . A value used by BookManager Library Reader for Windows when you have not explicitly specified one. Some default values are
shipped with BookManager Library Reader for Windows, and some may have been set by you or whomever installed BookManager
Library Reader for Windows for you. Default values can usually be changed.

default button . In some dialog boxes, the command button that Windows automatically selects. The default button has a bold border,
indicating that it will be chosen if you press Enter. You can override a default button by choosing Cancel or another command button. (W)

delete. To permanently erase an object from disk storage. After deleting the object, you will not be able to use it again without recreating
it. Contrast with remove.

deselect . Toremove an item from a selection. Contrast with select and mark.

dimmed . Unavailable or disabled. A dimmed button or command is displayed in light gray instead of black, and it cannot be chosen. (W)

directory . An ordered or classified list used to find the locations of things, such as files. A directory that is part of another directory is a
subdirectory.

disk . A medium for storing information. Information stored on a disk remains there even when you turn your computer off, unlike
information stored in memory (RAM). A floppy disk can be inserted and removed from a floppy disk drive, whereas a hard disk is
permanently mounted inside its drive. (W) Contrast with random access memory (RAM). See also disk drive.

disk drive . A device used for storing and retrieving information on disks. (W)

document . Whatever you create with an application, including information you type, edit, view, or save. A document may be a business
report, a spreadsheet, a picture, or a letter, for example, and is stored as a file on a disk. (W)

Document Composition Facility (DCF) . An IBM licensed program that prepares files for printing or softcopy display with BookManager.

document number . The form number of a manual that can be used to order copies of the manual. The document humber for softcopy
is displayed in the book description and can be displayed on the bookshelf.

documentation directory . The directory in which you tell BookManager Library Reader for Windows to store the product's softcopy
books during installation, and in which you can also store other softcopy books. C:\BOOKS is a typical documentation directory.

DOS share mode . Synonym for share mode.

double-click . To rapidly press and release a mouse button twice without moving the mouse. Double-clicking carries out an action, such
as starting an application. (W) Contrast with click.

download . To send information from a mainframe computer to an attached personal computer. Contrast with upload.

drag. To move an item on the screen by selecting the item and then pressing and holding down the mouse button while moving the
mouse. For example, you can move a window to another location on the screen by dragging its title bar. (W)
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drive . See disk drive.

dynamic link library (DLL) . A file containing executable code and data bound to a program at load time or run time, rather than during
linking. The code and data in a dynamic link library can be shared by several applications simultaneously.

+o-t
1 1
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ellipsis . A symbol (...) used with a menu command to indicate that choosing that command causes a dialog box to appear.

emphasized phrases . Phrases in topic text whose color makes them stand out from the rest of the text. Emphasis means that the
phrase is a search match.

erase. Synonym for delete.

exact match . A word or phrase found by BookManager Library Reader for Windows during a book search, that corresponds exactly to
the word or phrase typed in the search request. Contrast with fuzzy match.

exit. To end the current BookManager Library Reader for Windows session.

expand . To click on the (+) icon next to a topic title, thereby causing the titles of all its subtopics to come into view. See also subtopic and
click.

extension . The period and up to three characters at the end of a file name. An extension usually identifies the kind of information a file
contains. (W) For example, a book file has an extension of .BOO, a bookshelf file .BKS, a search index file .BKI, and a notes file .NTF.

+o-t
1 1
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figure . A vector graphic, image, or other kind of illustration in the text of a document that is identified by a title or caption and a sequential
number.

figure list . A list in a softcopy or hardcopy book that displays all numbered figures contained in the book.

FIGURES. The topic ID of a topic in a softcopy book that contains the list of figures in the book.

file extension . Synonym for extension.

fixed disk . Synonym for disk.

font. A set of letters, numbers, punctuation marks, and symbols that are a given size and design. (W)

footnote . A note of reference, explanation, or comment printed at the bottom of a printed page or shown in a footnote window.

footnote symbol . A number or character enclosed in parentheses and appended to the end of a word in a softcopy book. A footnote
symbol is the softcopy equivalent of a superscript number in a printed book. Because a footnote symbol is also a link, you can click on it
and view the text of the footnote.

front matter . Topics such as the preface, abstract, table of contents, list of figures or list of tables that are placed before the main
chapters or topics in a softcopy book.

fuzzy match . A word or phrase found by BookManager Library Reader for Windows during a single-book or multiple-book search, that is
a variation the word typed in a search request. Contrast with exact match.

+o-t
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generalized markup language (GML) . A document markup language that identifies and describes each document element.
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graphic . Pertaining to pictorial material or the output of graphics software, in contrast to text. Graphics in a softcopy book can be
integrated in the topic text, or displayed separately in the Picture window. See also raster image.

graphics reference link . A word or phrase in the text of an online book that represents a figure. A user can view the figure in the Picture

window by double-clicking on the graphics reference link, or by moving the cursor to the link and pressing Enter.

group window . A window that displays the items in a group within Program Manager. These items may be applications, accessories, or
documents. (W)

+--mt
| H
+--mt
hardcopy . Printed copies of books, manuals, or other information. Contrast with softcopy.
heading . Words indicating the beginning of a new topic or section.
highlighted . Indicates that an object or text is selected and will be affected by your next action. Highlighted text appears in reverse video

on monochrome monitors or in color on some color monitors. Highlighted objects might change color or be surrounded by a selection
cursor. (W)

horizontal topic text scroll bar . A bar that appears at the bottom of the left side of the Book window when the lines of text are too wide
to be displayed completely.

hypertext . A method of accessing information in a nonlinear fashion. This methodology is usually implemented by providing places in the
text where the reader can link to more information on a particular graphic or idea.

hypertext link . An automatic connection between an element in one part of a softcopy book to another element in the same book or to
another softcopy book. The link is a pointer from a location in a softcopy document to another location in the same document. It lets you
move without scrolling or explicitly requesting to go to the new location.

icons . Graphical representations of various elements in Windows, such as disk drives, applications, embedded and linked objects, and
documents. (W)

image. See raster image. Contrast with vector graphic.
ImageMark Software Labs, Inc . Developer of ImageStream Graphics Filters.
ImageStream Graphics Filters . A trademark of ImageMark Software Labs, Inc. Graphics filters convert various graphics formats from

one to another.

inactive window . An open window with which you are not currently interacting. An inactive window is not available for user interaction
until it becomes active again. Contrast with active window.

index . An alphabetical list of the subjects in a softcopy document and the topics in which each subject is found. Contrast with search
index.

initial value . Information present in a text box when that box is first displayed. See also default.

integrated pictures . Pictures that are either vector graphics or images, and which you can view within the Book window at the points at
which they occur in the text. Contrast with picture link. See also norunin image and runin image.

intra-document link . A link that connects two document elements within the same softcopy document. Contrast with cross-book link.

+o-t
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jump . Synonym for link.
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keys help . A type of help information that lists the default key assignments for a particular window.

keyword . A significant and informative word that describes the content of a list of choices.

+o-t
1 1
1 L 1
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label. A name assigned to each set of search matches found during the search of a book or topic. The label initially assigned is the first
few words or phrases from the list of search words and phrases.

LAN administrator . A person responsible for setting up a local area network (LAN), determining the directory/subdirectory structure of
the LAN files, and maintaining the LAN.

link. (1) A connection between related pieces of information. (2) To go to a related piece of information by activating the connection. See
also hypertext link, cross-reference link, and cross-book link.

link source . An object from which a link is made. A link source can be text or artwork. Contrast with link target.

link target . The object to which a link is made. A link target can be another place in the same book or a place in another book. A link
target can be text or artwork. Contrast with link source.

List of Books window . A window that displays books found in the directories you have specified. The books listed on this window do not
necessarily have to be in the same bookshelf. Contrast with Bookshelf window.

List of Bookshelves window . The first window that BookManager Library Reader for Windows displays if you start it without specifying a
particular bookshelf or book. This window lists all the bookshelves that can be found in your startup path.

list of figures . See figure list.

list of tables . See table list.

local area network (LAN) . A network established in a limited area to permit sharing of common computer resources.

+o-t
1 1
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margin . In BookManager Library Reader for Windows the unoccupied space between the left edge of the Book window and the start of
the topic text. The margin of a softcopy book can contain note icons or revision characters.

mark. To identify a section of text on which BookManager Library Reader for Windows is to perform some task, for example printing or
copying. An area that is marked is displayed in reverse video.

match . A word or phrase that is identical or similar to the words or phrases in a search request.

maximize . To make a window as large as possible. Contrast with minimize.

message . Information that the computer automatically generates and presents to you.

message area . The area of a window in which BookManager Library Reader for Windows sometimes displays messages. Contrast with
message window.

message help . Online help information that describes the purpose, use, or contents of a computer message. Contrast with contents
help, context-sensitive help, and short help.

message window . A window that appears when BookManager Library Reader for Windows displays a message of particular
importance. The text of the message appears in the message window. Contrast with message area.
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minimize . To reduce a window to an icon. Contrast with maximize.

monospaced . Pertaining to a type font that displays and prints each character at equal widths; for example, a w takes up the same
space as ani.

monospaced font . A font in which all characters have uniform widths, such as Courier New. (W) Contrast with proportional font.

mouse . A device you move on a flat surface to position a pointer on the screen. A mouse lets you select a choice or function to be
performed or to perform an action on the screen, such as marking an area of text, or dragging an object.

mouse button . A mechanical button usually located on top of a mouse that you press to make selections on the screen or begin
computer actions. See mouse button 1 and mouse button 2.

mouse button 1 . Generally the button on a mouse located closest to the screen. On a mouse operated with the right hand, it is usually
the left button. On a mouse operated with the left hand, it is usually the right button.

mouse button 2 . On a two-button mouse operated with the right hand, the right button. On a two-button mouse operated with the left
hand, the left button. On a three-button mouse, the middle button.

mouse pointer . The arrow-shaped cursor on the screen that follows the movement of a mouse (or other pointing device) and indicates
which area of the screen will be affected when you press the mouse button. The pointer may change shape during certain tasks. (W)

multimedia . A combination of various media, such as sound, graphics, animation, and video. (W)

+o-t
1 1
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navigate . To locate and work with information in a book.

navigator windows . Windows that help you find and go to information in a softcopy book. In BookManager Library Reader for Windows
the following are navigator windows: Topics, Search Results, Topics-Seen, Notes List, Revisions, Figures, Tables, and Index.

next topic match . The first match in the next topic that has matches for a given search.

norunin image . An image that appears on a line by itself, although it can have topic text above or beneath it. Contrast with runin image.

note. Additional information or comments that you attach to a line of text or an integrated picture in a softcopy document.

notes file . A file in which BookManager Library Reader for Windows stores notes. The notes file extension is usually .NTF.

notes file path . The path you specify using the Options - Startup Defaults window that tells BookManager Library Reader for Windows
where to find and store notes.

numeric key pad . The number keys, function keys, and direction keys at the far right side of the keyboard.

+--mt
i Ci
+--mt
object . Anything that you can focus attention on and manipulate as a single unit, for example, a book or a bookshelf.
online . Connected to, served by, or available through, a system or computer.
online book . Synonym for book.

online help . Synonym for contents help.

online information . Information stored in a computer system that can be displayed, used, and modified in an interactive manner without
any need to obtain hardcopy.
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open. To retrieve and display a specific bookshelf, book, topic, note, or picture and display it in a window so that you can see its contents.

operating system . An organized collection of programs that controls the overall operation of a computer.

Operating System/2 (0S/2) . A family of IBM licensed program operating systems for most IBM Personal System/2 models.

option . A choice in a dialog box. (W)

0S/2. Synonym for Operating System/2.

+o-t
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parameter . Synonym for option.

paste. To copy the contents of the Clipboard into an application. Many applications have a Paste command on the Edit menu that
performs this task. (W)

path. The storage location of a file. The path includes the drive, directory, and, if applicable, the line of subdirectories leading to the
directory in which the file resides. See startup path and notes file path.

Personal System/2 (PS/2) . A family of IBM personal computer systems ranging from a low-price, general-purpose computer system
offering approximately two times the processor performance of 8088-based IBM Personal Computers up to high-performance systems
that support advanced multitasking and multiuser applications and network services. The PS/2 is designed primarily for stand-alone
operation but may be connected to a mainframe or a network.

phrase . In a BookManager Library Reader for Windows search request, a collection of two or more words treated as a unit.

picture . Anillustration (image or graphic) in a softcopy document that can be displayed either integrated in topic text, or separately in a
Picture window.

picture identifier . A word or phrase in the text of a softcopy document that represents a piece of artwork, when the artwork is not
integrated in the topic text.

picture link . A highlighted set of words or characters that appear in BookManager Library Reader for Windows where a picture would
normally occur in a printed book. Each picture link appears on a line by itself and consists of the word PICTURE followed by either a
number or name.

profile . A file containing default options or options that you specified to tell BookManager Library Reader for Windows functions how to
operate. See also startup options.

program-item icon . The icon that represents the BookManager Library Reader for Windows application in the BookManager Library
Reader for Windows group window in Microsoft Windows Program Manager. You can start the Library Reader for Windows application
by choosing its program-item icon.

proportional font . A font in which different characters have varying widths, such as Times New Roman. (W)

PS/2. Synonym for Personal System/2.

+o-t
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random access memory (RAM) . The memory that can be used by applications to perform necessary tasks while the computer is on.
When you turn the computer off, all information in RAM is lost. (W)
ranking . See search ranking.

raster image . A type of computer graphics in which a display image is composed of an array of picture elements (pixels) arranged in
rows and columns. Contrast with vector graphic.
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read-only access . A type of access that allows data to be read but not modified. Contrast with read/write access.

read/write access . A type of access that lets you get information from and put information into a file. Contrast with read-only access.

reboot . To restart a program or operating system. On a workstation you typically reboot by pressing CTRL+ALT+DEL, or by powering

off and then on again.

reference . Synonym for cross-reference link.

reflow . The ability to wrap lines of text within existing margins by splitting lines between words.

reflowable text . Text that reflows to fit a window that has been resized.

refresh . To update the information that you are currently viewing.

remove . Toremove a book from a bookshelf. This action does not physically delete the book from disk storage, but only erases the
book's name from the bookshelf list.

resource sharing . (1) In word processing, an arrangement in which two or more workstations share common facilities. (T) (2)
Directories, data files, programs, printers, plotters, and serial devices (such as modems) made available to users on a network. Users
access these resources from their own computer or workstation. See also share mode.

reverse video . A method of highlighting text by reversing the color of the characters with the color of the background. For example, in a
window using black characters on a white background, reverse video text would use white characters on a black background.

revision character . A character in the margin, such as a bar (]), that indicates that the text line beside it has been changed by the author.
revision code . Synonym for revision character.

revision symbol . Synonym for revision character.

revisions . Changes an author has made to a book. Revisions may be marked with revision characters.

root directory . The top-level directory of a disk. The root directory is created when you format the disk. From the root directory, you
can create files and other directories. (W)

runin image . In hardcopy, a picture with topic text on one or both sides. Contrast with norunin image.

+o-t
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scan. Using a scanner device to convert a paper picture to computer image form.

scanner . A device that produces a computer image from a picture on a piece of paper.

screen . The physical surface of a display device upon which information is shown to you. See also window.

scroll . To move a display image vertically or horizontally to view data that is not otherwise visible in a window.

search . A powerful BookManager Library Reader for Windows function that lets you locate specified words and phrases within multiple
books on a bookshelf, a single book, or selected topics. When the search is complete, any words or phrases that match the specified
words or phrases are emphasized in the text of the book or are presented in a Search Results or a Multiple-Book Search Results window.

search emphasis . Color or intensity that makes search matches stand out from the rest of the text in a softcopy document.

search index . An index of all information in the books on a bookshelf, created with BookManager BUILD or BookManager READ. The
search index is usually created as a file that has the same name as the bookshelf, and an extension of .BKI. Using a search index can
make searching the books in a bookshelf significantly faster.
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search options . In BookManager Library Reader for Windows, the options you can set to specify which type of search dialog box is to
appear; what areas of the book to search; what type of search to do; and how to show results.

search ranking . The method BookManager Library Reader for Windows uses to organize search matches.

search results . In a single-book or multiple-book search, a list a topics that contain one or more search matches.

select. To mark an item so that a subsequent action can be carried out on that item. You usually select an item by clicking it with a
mouse or pressing a key. After selecting an item, you choose the action that you want to affect the item. (W) Contrast with choose.

session . The period of time that begins when you start a program or open an object, and ends when you end the program or close the
object. See BookManager Library Reader for Windows session and book session.

share mode . In BookManager Library Reader for Windows, a DOS mode of operation that permits sharing of such resources as files,

directories, and printers. See also resource sharing.

size. To make a window larger or smaller by moving its vertical and horizontal borders.

softcopy . Online information that can be electronically distributed, manipulated, and printed. Contrast with hardcopy.

sort. To arrange a set of items to be used in a specified sequence, such as alphabetic or numeric.

startup options . Options you can append to the READIBM command to start the BookManager Library Reader for Windows application
in a variety of different ways.

startup path . The path you specify using the Options - Startup Defaults window that tells BookManager Library Reader for Windows
where to find bookshelves and books when it starts up.

status area . The window area that displays the topic heading, security information, and copyright information for the current topic in the
Book window.

subdirectory . A directory within another directory. (W)

subtopic . A topic that is subordinate to a higher-level topic. For example, 2.1 and 2.2 are subtopics of topic 2.0.

+o-t
1 1
1 T 1
+o-t

table. Information presented in rows and columns and defined by the author as a table.

table list . A list of all numbered tables contained in a book.

table of contents . A list of topics in the order in which they appear in a book. Contrast with index.

TABLES . The topic ID of a topic in a softcopy document that contains the list of tables in the book.

target. See link target.

text. A graphic representation of information on an output medium. Text can consist of alphanumeric characters and symbols arranged
in paragraphs, tables, columns, or other shapes. Contrast with graphic and raster image.

text cursor . A symbol displayed in a text box that shows you where information you type, or paste from the Clipboard, will appear.

Synonym for insertion point.

topic . A heading and its subsequent text up to the next heading; the basic unit of information in a BookManager Library Reader for
Windows softcopy document.

topic heading . A heading that introduces each new topic in softcopy. Each topic heading is made up of two parts: a topic ID and a topic
title. See topic identifier and topic title.
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topic number . Synonym for topic identifier.

topic text scroll bar . A bar that appears at the right edge of the left side of the Book window and that can be used to scroll the topic text
vertically.
topic title . The title that is associated with a topic heading. See also topic.

topics list . The list of all the topics in a softcopy document that have topic IDs. This list appears in the right half of the Book window, or in
the Topics navigator window, or in both places.

+o-t
1 1
1 U 1
+o-t

unavailable choice . A command in a menu that you cannot choose due to the state or condition of the items in the window, the window
itself, or the BookManager Library Reader for Windows application. For example, menu commands that apply an action to a book or
bookshelf are unavailable if no book or bookshelf has been selected. An unavailable choice is dimmed. Contrast with available choice.
See also dimmed.

Unicode . See universal code page.

universal code page . (1) A character encoding standard consisting of a 16-bit width, uniform text encoding scheme. (2) Defines codes
for characters used in every major language of the world.

unlink . To return to the location in topic text where a you selected a hypertext link (the link source). See link source.

upload . To transfer data from a device such as a workstation or microcomputer to a mainframe computer. Contrast with download.

+o-t
1 1
1 V 1
+o-t

variations . Words in the softcopy book that are similar in spelling to a word entered in a search request.

vector graphic . Computer graphics in which display images are generated from display commands and coordinate data. (I) (A) Contrast
with raster image.

+o-t
1 1
1 \A 1
+o-t

warning message . Information provided by a computer to indicate a possible error condition. A warning message also tells you that to
perform the action you are requesting can cause an undesirable condition. You may be required to confirm the action or take other steps.

wildcard . The character used to substitute for unknown or unspecified characters or words in a search word or phrase. An asterisk (*)
is an example of a wildcard character.

wildcard character . Synonym for wildcard.

window . A rectangular area on your screen in which you view an application or document. You can open, close, and move windows, and

change the size of most windows. You can open several windows at a time, and you can often reduce a window to an icon or enlarge it to
fill the entire desktop. Sometimes windows are displayed within other windows. (W)

word . For the purpose of a BookManager Library Reader for Windows search, a character string that is considered as a unit and does
not exceed 60 characters.

+o-t

+o-t

zoomin . To enlarge a selected portion of a picture.
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zoom out . To reduce in size a portion of a picture that has been enlarged.
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